# Contents

## 1 Safety

- Electrical Safety .................................................................................................................. 10
- General Guidelines .............................................................................................................. 10
- Operational Safety ............................................................................................................... 11
  - Ozone Release .................................................................................................................. 11
  - Printer Location ................................................................................................................ 11
  - Operational Guidelines ..................................................................................................... 11
  - Power Cord ....................................................................................................................... 12
  - Printer Supplies ................................................................................................................ 12
- Maintenance Safety ............................................................................................................. 13
- Printer Symbols ................................................................................................................... 14

## 2 Features

- Parts of the Printer ............................................................................................................... 16
  - Left Front View of Phaser 7800DN Color Printer ............................................................ 16
  - Left Front View of Phaser 7800GX Color Printer ............................................................ 17
  - Left Front View of Phaser 7800DX Color Printer ............................................................ 18
  - Rear View ....................................................................................................................... 18
  - Control Panel ................................................................................................................... 19
  - Internal Components ...................................................................................................... 19
  - Professional Finisher ........................................................................................................ 20
  - Advanced Finisher .......................................................................................................... 21
- Information Pages .............................................................................................................. 22
  - Printing the Configuration Report .................................................................................. 22
- Energy Saver Mode ............................................................................................................ 23
- Administration Features .................................................................................................... 24
  - CentreWare Internet Services ......................................................................................... 24
  - Automatic Data Collection .............................................................................................. 25
  - Billing and Usage Information ....................................................................................... 25
- More Information ................................................................................................................ 26

## 3 Installation and Setup

- Installation and Setup Overview ......................................................................................... 28
  - Physically Connecting the Printer to the Network ............................................................ 28
  - Turning the Printer On and Off ....................................................................................... 29
  - Initial Printer Setup .......................................................................................................... 29
  - Optimizing Printer Performance ..................................................................................... 29
- Modifying General Settings ............................................................................................... 30
Contents

Installing the Software .................................................................................................................. 31
  Operating System Requirements .............................................................................................. 31
  Installing Drivers and Utilities for Windows ............................................................................ 32
  Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later ....................... 33
  Installing Drivers and Utilities for UNIX and Linux ............................................................... 34
  Other Drivers ............................................................................................................................. 34

4 Paper and Media ..................................................................................................................... 35
  Supported Paper ....................................................................................................................... 36
    Recommended Media ............................................................................................................... 36
    Ordering Paper ...................................................................................................................... 36
    General Paper Loading Guidelines ...................................................................................... 36
    Paper That Can Damage Your Printer .................................................................................. 37
    Paper Storage Guidelines ..................................................................................................... 37
    Advanced Finisher Guidelines .............................................................................................. 38
    Professional Finisher Guidelines .......................................................................................... 38
    Supported Paper Types and Weights .................................................................................... 39
    Supported Standard Paper Sizes for Phaser 7800DN and 7800GX Color Printers .......... 39
    Supported Standard Paper Sizes for the Phaser 7800DX Color Printer ............................ 40
    Supported Paper Sizes and Weights for Automatic 2-Sided Printing ................................. 40
    Supported Custom Paper Sizes ............................................................................................ 40
  Loading Paper .......................................................................................................................... 41
    Loading Paper in Tray 1 ......................................................................................................... 41
    Loading Paper in Trays 2–5 ................................................................................................... 45
    Setting the Guide Locks in the 500-Sheet Adjustable Trays ................................................ 49
    Changing Paper Size, Type, and Color .................................................................................. 52
  Printing on Special Paper ........................................................................................................ 53
    Envelopes ............................................................................................................................... 53
    Labels .................................................................................................................................... 55
    Glossy Cardstock ................................................................................................................... 56
    Transparencies ...................................................................................................................... 56

5 Printing ................................................................................................................................... 57
  Printing Overview .................................................................................................................... 58
  Selecting Printing Options ........................................................................................................ 59
    Print Driver Help ................................................................................................................... 59
    Windows Printing Options .................................................................................................... 60
    Macintosh Printing Options .................................................................................................. 61
## 6 Maintenance

General Precautions ................................................................................................. 76
Cleaning the Printer ................................................................................................. 77
Cleaning the Printer Exterior ................................................................................... 77
Cleaning the Printer Interior .................................................................................... 78
Routine Maintenance ............................................................................................... 84
Replacing Staple Cartridges ..................................................................................... 84
Emptying the Hole Punch Waste Container ............................................................. 91
Billing and Usage Information .................................................................................. 94
Ordering Supplies ...................................................................................................... 95
Locating the Serial Number ..................................................................................... 95
Consumables ............................................................................................................ 95
Routine Maintenance Items ..................................................................................... 96
Customer Replaceable Units ................................................................................... 96
Other Supplies .......................................................................................................... 96
When to Order Supplies ......................................................................................... 97
Viewing Printer Supply Status ................................................................................ 97
Recycling Supplies ................................................................................................... 97
Moving the Printer .................................................................................................... 98

## 7 Troubleshooting

General Troubleshooting ......................................................................................... 100
Printer Does Not Turn On ....................................................................................... 100
Printer Resets or Turns Off Frequently ................................................................. 101
Printing Takes Too Long ......................................................................................... 101
Document Prints From Wrong Tray ....................................................................... 101
Document Fails to Print ........................................................................................... 102
Printer is Making Unusual Noises ......................................................................... 102
Automatic 2-Sided Printing Problems .................................................................. 103
Date and Time Are Incorrect .................................................................................. 103
Contents

Jams........................................................................................................................................104
  Clearing Paper Jams ...........................................................................................................105
  Clearing Jams in the Advanced Finisher........................................................................121
  Clearing Jams in the Professional Finisher ......................................................................123
  Minimizing Paper Jams ......................................................................................................134
  Troubleshooting Paper Jams ............................................................................................135
  Clearing Staple Jams ........................................................................................................137

Print-Quality Problems ........................................................................................................146
  Controlling Print Quality ..................................................................................................146
  Solving Print-Quality Problems ......................................................................................148

Getting Help .........................................................................................................................152
  Control Panel Messages ..................................................................................................152
  Using the Integrated Troubleshooting Tools ..................................................................155
  More Information ............................................................................................................158

A Specifications ....................................................................................................................159

Printer Configurations and Options .....................................................................................160
  Standard Features ............................................................................................................160
  Available Configurations ...............................................................................................161
  Options and Upgrades .....................................................................................................161

Physical Specifications .........................................................................................................162
  Phaser 7800DN Color Printer Configuration ................................................................162
  Phaser 7800GX Color Printer Configuration ................................................................162
  Phaser 7800DX Color Printer Configuration ................................................................162
  Configuration with Advanced Finisher and Booklet Maker .........................................162
  Configuration with Professional Finisher ....................................................................162
  Clearance Requirements .................................................................................................163

Environmental Specifications ..............................................................................................165
  Temperature .....................................................................................................................165
  Relative Humidity ............................................................................................................165
  Elevation ........................................................................................................................165

Electrical Specifications .........................................................................................................166
  Power Supply Voltage and Frequency ...........................................................................166
  Power Consumption ........................................................................................................166
  ENERGY STAR Qualified Product .................................................................................166

Performance Specifications ..................................................................................................167
  Printing Resolution .........................................................................................................167
  Print Speeds .....................................................................................................................167
B Regulatory Information

Basic Regulations
United States FCC Regulations
Canada
European Union
Germany
Turkey RoHS Regulation
Material Safety Data Sheets

C Recycling and Disposal

All Countries
North America
European Union
Domestic/Household Environment
Professional/Business Environment
Collection and Disposal of Equipment and Batteries
Battery Symbol Note
Battery Removal
Other Countries
Safety

This chapter includes:

- Electrical Safety .............................................................. 10
- Operational Safety ............................................................ 11
- Maintenance Safety ............................................................ 13
- Printer Symbols ................................................................... 14

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox® printer.
Electrical Safety

General Guidelines

**WARNINGS:**

- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electrical shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Turn off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer emits unusual noise or odors.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on print volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the printer. To find the weight for your printer configuration, see Physical Specifications on page 162.
- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in an area where there is adequate space for operation and servicing.
- Place the printer in a dust-free area.
- Do not store or operate the printer in an extremely hot, cold, or humid environment.
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at elevations recommended in Elevation on page 165.

Operational Guidelines

- Do not remove the paper source tray that you selected in either the print driver or control panel while the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and so on away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.
Safety

Power Cord

- Use the power cord supplied with your printer.
- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.

⚠️ **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is grounded properly. Electrical products can be hazardous if misused.

- Only use an extension cord designed to handle the electrical current capacity of the printer.
- Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.
- Do not place the printer in an area where people can step on the power cord.
- Do not place objects on the power cord.
- Do not plug or unplug the power cord while the power switch is in the On position.
- If the power cord becomes frayed or worn, replace it.
- To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all consumable supplies in accordance with the instructions given on the package or container.
- Keep all consumable supplies away from the reach of children.
- Never throw consumable supplies into an open flame.
- When handling cartridges, for example toner cartridges, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or eye contact.

⚠️ **CAUTION:** Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.
## Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Warning" /></td>
<td>Warning or Caution: Ignoring this warning could cause serious injury or even death. Ignoring this caution could damage property.</td>
</tr>
<tr>
<td><img src="image2" alt="Hot Surface" /></td>
<td>Hot surface on or in the printer. Use caution to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image3" alt="Do Not Burn" /></td>
<td>Do not burn the item.</td>
</tr>
<tr>
<td><img src="image4" alt="Do Not Lift" /></td>
<td>Do not lift here.</td>
</tr>
<tr>
<td><img src="image5" alt="Hot Surface" /> <img src="image6" alt="Time" /></td>
<td>Hot surface. Wait the indicated time before handling.</td>
</tr>
<tr>
<td><img src="image7" alt="Recycle" /></td>
<td>This item can be recycled. For details, see <a href="#">Recycling and Disposal</a> on page 173.</td>
</tr>
</tbody>
</table>
This chapter includes:

- Parts of the Printer ................................................................. 16
- Information Pages ................................................................. 22
- Energy Saver Mode ................................................................. 23
- Administration Features ......................................................... 24
- More Information ................................................................. 26
Parts of the Printer

This section includes:

- Left Front View of Phaser 7800DN Color Printer ................................................................. 16
- Left Front View of Phaser 7800GX Color Printer .................................................................... 17
- Left Front View of Phaser 7800DX Color Printer .................................................................... 17
- Rear View .................................................................................................................................. 18
- Control Panel .............................................................................................................................. 18
- Internal Components .................................................................................................................. 19
- Professional Finisher .................................................................................................................. 20
- Advanced Finisher ...................................................................................................................... 21

Left Front View of Phaser 7800DN Color Printer

1. Tray 1, with Extension Tray
2. Left Side Door B
3. Left Side Door A
4. Left Side Door D
5. Control Panel
6. Output Tray
7. Center Output Tray
8. Secondary Power Switch
9. Front Door
10. Tray 2
Left Front View of Phaser 7800GX Color Printer

1. Left Side Door C
2. Tray 1, with Extension Tray
3. Left Side Door B
4. Left Side Door A
5. Left Side Door D
6. Control Panel
7. Output Tray
8. Center Output Tray
9. Secondary Power Switch
10. Front Door
11. Tray 2
12. 1500-Sheet Feeder (Trays 3–5)
13. Tray 3
14. Tray 4
15. Tray 5
Left Front View of Phaser 7800DX Color Printer

1. Left Side Door C
2. Tray 1, with Extension Tray
3. Left Side Door B
4. Left Side Door A
5. Left Side Door D
6. Control Panel
7. Output Tray
8. Center Output Tray
9. Secondary Power Switch
10. Front Door
11. Tray 2
12. 2500-Sheet Feeder (Trays 3–5)
13. Tray 3
14. Tray 5
15. Tray 4

Rear View

1. USB Connection
2. USB Memory Port, for service only
3. Ethernet Connection
4. Power Connector for Finisher
5. Power Connector for Printer
Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on the printer. The control panel:

- Displays the current operating status of the printer.
- Provides access to print features.
- Provides access to reference materials.
- Provides access to Tools and Setup menus.
- Provides access to Troubleshooting menus and videos.
- Prompts you to load paper, replace supplies, and clear jams.
- Displays errors and warnings.
- Plays event-driven videos.

1. **Touch Screen** displays information and provides access to printer functions.
2. **Power Saver** enters Sleep mode, and exits Low Power or Sleep mode.
3. **Pause** temporarily stops the current print job, allowing you to cancel or resume the job.

Internal Components

1. Transfer Roller
2. Fuser
3. Imaging Unit Lock Lever
4. Toner Cartridges
5. Main Power Switch
6. Transfer Belt Cleaner
7. Waste Cartridge
8. Imaging Units
9. Imaging Unit Cover
Professional Finisher

1. Center Tray
2. Hole Punch Unit
3. Hole Punch Waste Container
4. Finisher Front Door
5. Right Top Tray
6. Exit Cover
7. Right Middle Tray
8. Staple Cartridge
9. Booklet Maker Bin
10. Booklet Staple Assembly
11. Booklet Maker
Advanced Finisher

1. Front Transport Cover
2. Hole Punch Unit (optional)
3. Hole Punch Waste Container
4. Center Tray
5. Finisher Top Cover
6. Staple Cartridge for optional Booklet Maker
7. Side Cover for optional Booklet Maker
8. Booklet Maker (optional)
9. Right Tray
10. Right Tray Extension
11. Creaser Unit
12. Staple Cartridge
13. Finisher Front Door
14. Advanced Finisher
Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

To print information pages from the control panel:
1. At the control panel, touch **Printer**.
2. On the Information tab, touch **Print Reference Materials**.
3. To set the quantity, touch #.
4. To select the number of copies to print, touch + or -, or type a number using the keypad.
5. Touch **OK**.
6. To scroll through the list as needed, use the **Up** or **Down** Arrow, then touch the page you want to print.
7. Touch **Print**.

   **Note:** You can also print Information pages from CentreWare Internet Services.

To specify the source tray for printing the information pages:
1. At the control panel, touch **Printer**.
2. Touch the **Tools** tab, then touch **Tray Management**.
3. Touch **Information Pages Source**.
4. Touch the specific tray you want the printer to use, or touch **Automatic**.
5. Touch **OK** to confirm the setting.
6. Touch **Back** to return to the Tools tab, or touch **Home** to return to the main screen.

**Notes:**
- To print pages that can help you with print-quality problems, see Using the Integrated Troubleshooting Tools on page 155.
- Some of the control panel screens contain links to frequently used information pages.

Printing the Configuration Report
1. At the control panel, touch **Printer**.
2. On the Information tab, touch **Print Reference Materials**.
3. Touch **Configuration Report**.
4. Touch **Print**.

   **Note:** By default, the Configuration Report prints each time the printer is turned on. To turn off this setting, select **Printer > Tools > Setup > General Settings > Startup Page > Off**.
Energy Saver Mode

You can set the time the printer spends idle in ready mode before it automatically transitions to a lower power level. You can also turn off the automatic transition.

1. At the control panel, touch **Printer**.
2. Touch the **Tools** tab, then touch **Setup**.
3. Touch **Energy Saver**.
4. Enable the automatic transition:
   a. Select the **Enable Energy Saver** check box.
   b. To change each option, touch **Edit**:
      - Ready Mode to Low Power
      - Low Power to Sleep
   c. Enter the minutes from 1–120 using the keypad. The Low Power default setting is 15. The Sleep default setting is 45.
   d. To confirm the change, touch **OK**, or **X** to cancel it.
5. To return to the Setup screen, touch **OK**.

**Notes:**
- To turn off the automatic transition, clear the Enable Energy Saver check box.
- The printer exits Energy Saver mode when it receives a print job, or when you press the Power Saver button.
Administration Features

This section includes:

- CentreWare Internet Services .................................................................................................................. 24
- Automatic Data Collection .......................................................................................................................... 25
- Billing and Usage Information ................................................................................................................... 25

For details, see the System Administrator Guide at www.xerox.com/office/7800docs.

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser.

CentreWare Internet Services requires:

- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

Accessing CentreWare Internet Services

At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.

Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report. For details, see Printing the Configuration Report on page 22.

To view the IP address on the control panel:

1. At the control panel, touch Printer.
2. On the Information tab, touch About This Printer.
3. Touch the Network tab.
   The IP address appears under TCP/IP (v4).
4. If IPv6 is set up, touch TCP/IP (v6) to view details.
5. To return to the main screen, touch Home.

Note: The IP address can also appear in the upper right or left corner of the main screen. To set this up in CentreWare Internet Services, click Properties > General Setup > Control Panel Home Screen. For details, see the Help in CentreWare Internet Services.

Automatic Data Collection

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a designated servicer uses this data to support and service the printer, or for billing, supplies replenishment, or product improvement. Automatically transmitted data can include product registration, meter read, supply level, printer configuration and settings, software version, and problem or fault code data. Xerox cannot read, view, or download the content of your documents residing on or passing through your printer or any of your information management systems.

To turn off automatic data collection:

On the Welcome page in CentreWare Internet Services, click the link in the note regarding automated services.

Billing and Usage Information

Billing and printer usage information appears on the Billing Meters information screen. The impression counts shown are used for billing. For details on viewing this information, see Billing and Usage Information on page 94.
# More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Installation Guide</em></td>
<td>Packaged with printer</td>
</tr>
<tr>
<td><em>Quick Use Guide</em></td>
<td>Packaged with printer</td>
</tr>
<tr>
<td><em>System Administrator Guide</em></td>
<td><a href="http://www.xerox.com/office/7800docs">www.xerox.com/office/7800docs</a></td>
</tr>
<tr>
<td>Video Tutorials</td>
<td>Available on the printer control panel and at <a href="http://www.xerox.com/office/7800docs">www.xerox.com/office/7800docs</a></td>
</tr>
<tr>
<td>PhaserSMART Technical Support</td>
<td><a href="http://www.phasersmart.com">www.phasersmart.com</a></td>
</tr>
<tr>
<td>automatically diagnoses problems</td>
<td>on your network printer and proposes solutions.</td>
</tr>
<tr>
<td>Technical support information</td>
<td><a href="http://www.xerox.com/office/7800support">www.xerox.com/office/7800support</a></td>
</tr>
<tr>
<td>for your printer includes</td>
<td>Online Technical Support, Online Support Assistant, and driver downloads.</td>
</tr>
<tr>
<td>online Technical Support,</td>
<td></td>
</tr>
<tr>
<td>Online Support Assistant, and</td>
<td></td>
</tr>
<tr>
<td>driver downloads.</td>
<td></td>
</tr>
<tr>
<td>Information about menus or</td>
<td>Control panel Help (?) button</td>
</tr>
<tr>
<td>error messages</td>
<td></td>
</tr>
<tr>
<td>Information pages</td>
<td>Print from the control panel menu</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/office/7800supplies">www.xerox.com/office/7800supplies</a></td>
</tr>
<tr>
<td>A resource for tools and</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>information, such as interactive</td>
<td></td>
</tr>
<tr>
<td>tutorials, printing templates,</td>
<td></td>
</tr>
<tr>
<td>helpful tips, and customized</td>
<td></td>
</tr>
<tr>
<td>features to meet your individual</td>
<td></td>
</tr>
<tr>
<td>needs.</td>
<td></td>
</tr>
<tr>
<td>Local sales and support center</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com">www.direct.xerox.com</a></td>
</tr>
</tbody>
</table>
This chapter includes:

- **Installation and Setup Overview** ................................................................. 28
- **Modifying General Settings** ........................................................................... 30
- **Installing the Software** ................................................................................. 31

See also:

*Installation Guide* packaged with your printer.

Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer over a network using an Ethernet cable, or directly to your computer using a USB cable. Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet, and USB cables are not included with your printer and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a USB connection, and it provides access to CentreWare Internet Services.

For details on connection and network setup, print the Connection Setup page:
1. At the control panel, touch Printer.
3. Touch Connection Setup.
4. Touch Print.

For details on configuring the printer settings, see the System Administrator Guide at www.xerox.com/office/7800docs.

Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. Connect the other end of the Ethernet cable to a correctly configured network port on a hub or router.
3. Turn on the printer.
Turning the Printer On and Off

This printer has two power switches. The Main Power switch located behind the front door controls the main power to the printer. The Secondary Power switch on the top of the printer controls power to the printer electronic components, and initiates a software-controlled shutdown when turned off. Using the Secondary Power switch to turn on and off the printer is the preferred method.

To operate the printer, turn on both switches. First turn on the Main Power switch, then turn on the Secondary Power switch.

Initial Printer Setup

Make sure that the printer is set up before installing the printer software. Setup includes enabling the optional features and assigning an IP address for the Ethernet network connection. If the printer has not been previously turned on and configured, see the System Administrator Guide at www.xerox.com/office/7800docs.

Optimizing Printer Performance

Several factors influence printer performance, including temperature, humidity, air pressure, and the chemical characteristics of the paper and coatings. The printer must form an electrostatic image on the paper, which depends on the ability of the air to hold and transfer electrical charges. The paper and coatings must hold an electrical charge in the areas where the toner must adhere.

To optimize the performance of your printer:
1. At the control panel, touch Printer.
2. Touch the Tools tab, then touch Adjust Color.
3. Touch Color Calibration.
4. To print the Calibration pages, follow the onscreen instructions.
5. To adjust the printer color settings, follow the printed instructions.
6. Touch Done.
7. Touch Calibrate Paper Type.
8. To print the Calibrate for Paper pages, follow the onscreen instructions.
9. To adjust the printer for various paper types and environmental conditions, follow the printed instructions.
Modifying General Settings

You can modify printer settings such as the language, date and time, units of measurement, display brightness, and startup page from the control panel.

1. At the control panel, touch **Printer**.
2. Touch the **Tools** tab, then touch **Setup**.
3. Touch **General Settings**, then touch the setting you want to change:
   - **Language/Keyboard** allows you to set the language and keyboard layout.
   - **Date/Time** allows you to set the time zone, date, time, and display format.

**Note:** The date and time are automatically set through Network Time Protocol (NTP). To modify these settings, go to the Properties tab in CentreWare Internet Services and change the Date and Time Setup to **Manual (NTP Disabled)**.

- **System Timeout** allows you to specify how long the printer waits for input before returning to the main screen.
- **Display Brightness** allows you to set the brightness level of the touch screen.
- **Startup Page** allows you to specify if the Configuration Report prints each time the printer is turned on.

4. Change settings as needed.
5. To confirm the change, touch **OK**, or X to cancel it.
6. Modify other settings, or touch **Home** to return to the main screen.
Installing the Software

This section includes:

- Operating System Requirements ................................................................. 31
- Installing Drivers and Utilities for Windows .................................................... 31
- Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later .................... 32
- Installing Drivers and Utilities for UNIX and Linux ........................................... 33
- Other Drivers ...................................................................................................... 34

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you cannot find the IP address, see Finding the IP Address of the Printer on page 24.

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/7800drivers.

Operating System Requirements

- Macintosh OS X version 10.5 and later
- UNIX and Linux: Your printer supports connection to a variety of UNIX platforms through the network interface. For details, see www.xerox.com/office/7800drivers.
Installing Drivers and Utilities for Windows

Install the Xerox® print driver to access all features of your printer.

To install the print driver software:
1. Insert the Software and Documentation disc into your computer. The installer starts automatically. If the installer does not start, navigate to the appropriate drive on your computer and double-click Setup.exe.
2. To change the language, click Language, select your language, then click OK.
3. Click Agree to accept the license agreement.
4. Select your printer from the list of discovered printers, then click Install.
5. If your printer does not appear in the list of discovered printers, click Extended Search.
6. If the printer still does not appear in the list of discovered printers, and you know the IP address:
   a. Click the Network Printer Icon (right) at the top of the gray window.
   b. Enter the IP Address or the DNS name for the printer.
   c. Click Search, then select your printer from the list of discovered printers.
   d. Click Next when the printer appears in the window.
7. If the printer still does not appear in the list of discovered printers, and you do not know the IP address:
   a. Click Advanced Search.
   b. If you know the gateway address and subnet mask, click the top button and enter the addresses into the Gateway and Subnet Mask fields.
   c. If you know the IP address of another printer on the same subnet, enter the address in the IP Address field.
   d. Click Search, then select your printer from the list of discovered printers.
   e. Click Next when the printer appears in the window.
8. Select the desired print driver:
   • PostScript (recommended)
   • PCL 5
   • PCL 6
9. Click Install.
10. Click Finish when the installation completes.
Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later

Install the Xerox® print driver to access all features of your printer.

To install the print driver software:
1. Insert the Software and Documentation disc into your computer.
2. Double-click the disc icon on your desktop to see the .dmg file for your printer.
3. Open the .dmg file, and navigate to the appropriate installer file for your operating system.
4. Open the installer file.
5. Click Continue to acknowledge the warning and introductory messages.
6. Click Continue and accept the license agreement.
7. To accept the current installation location, click Install, or select another location for the installation files, then click Install.
8. Enter your password, then click OK.
9. Select your printer in the list of discovered printers, then click Continue.
10. If your printer does not appear in the list of discovered printers:
    a. Click the Network Printer Icon.
    b. Type the IP address of your printer, then click Continue.
    c. Select your printer in the list of discovered printers, then click Continue.
11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and later.

To verify that the print driver recognizes the installed options:
1. From the Apple menu, click System Preferences > Print.
2. Select the printer in the list, then click Options and Supplies.
3. Click Driver, then confirm that your printer is selected.
4. Confirm that all of the options installed on the printer appear correct.
5. If you change settings, click Apply Changes, close the window, and quit System Preferences.
Installing Drivers and Utilities for UNIX and Linux

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for UNIX Systems code package must be installed before installing the printer support package.

Note: You must have root or superuser privileges to perform the UNIX print driver installation on your computer.

1. At the printer, do the following:
   a. Verify that both the TCP/IP protocol and the proper connector are enabled.
   b. On the printer control panel, do one of the following for the IP address:
      • Allow the printer to set up a DHCP address.
      • Enter the IP address manually.
   c. Print the Configuration Report and keep it for reference. For details, see Configuration Report on page 22.

2. At your computer, do the following:
   a. Go to www.xerox.com/office/7800drivers and select your printer model.
   b. From the Operating System menu, select UNIX, then click Go.
   c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This package is the core package and must be installed before the printer support package.
   d. To begin downloading, click the Start button.
   e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX Systems package that you selected earlier. The second part of the driver package is ready for download.
   f. To begin downloading, click the Start button.
   g. In the notes below the driver package that you selected, click the link for the Installation Guide, then follow the installation instructions.

Notes:
   • To load Linux print drivers, perform the preceding procedures but select Linux as the operating system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You can also use the CUPS driver included in the Linux package.
   • Supported Linux drivers are available at www.xerox.com/office/7800drivers.
   • For details about UNIX and Linux drivers, see the System Administrator Guide at www.xerox.com/office/7800docs.

Other Drivers

The following drivers are available for download at www.xerox.com/office/7800drivers.
   • The Xerox® Global Print Driver works with any printer on your network, including those printers made by other manufacturers. It configures itself for your individual printer upon installation.
   • The Xerox® Mobile Express Driver works with any printer available to your computer that supports standard PostScript. It configures itself for the printer you select every time you print. If you travel frequently to the same sites, you can save your favorite printers in that location and the driver saves your settings.
Paper and Media

This chapter includes:

- Supported Paper ........................................................................................................................................... 36
- Loading Paper ............................................................................................................................................ 41
- Printing on Special Paper .......................................................................................................................... 53
Supported Paper

This section includes:

- **Recommended Media** ................................................................. 36
- **Ordering Paper** ............................................................................ 36
- **General Paper Loading Guidelines** ............................................. 36
- **Paper That Can Damage Your Printer** ........................................ 37
- **Paper Storage Guidelines** ............................................................. 37
- **Advanced Finisher Guidelines** .................................................... 37
- **Professional Finisher Guidelines** .................................................. 38
- **Supported Paper Types and Weights** .......................................... 39
- **Supported Standard Paper Sizes for Phaser 7800DN and 7800GX Color Printers** ........................................................................ 39
- **Supported Standard Paper Sizes for the Phaser 7800DX Color Printer** ........................................................................... 40
- **Supported Paper Sizes and Weights for Automatic 2-Sided Printing** .................................................................................. 40
- **Supported Custom Paper Sizes** .................................................... 40

Your printer is designed to use various paper and other media types. Follow the guidelines in this section to ensure the best print quality and to avoid jams.

For best results, use Xerox® paper and media recommended for your printer.

**Recommended Media**

A list of paper and media recommended for your printer is available at:

- [www.xerox.com/paper](http://www.xerox.com/paper) Recommended Media List (United States)
- [www.xerox.com/europaper](http://www.xerox.com/europaper) Recommended Media List (Europe)

**Ordering Paper**

To order paper, transparencies, or other media, contact your local reseller or go to [www.xerox.com/office/7800supplies](http://www.xerox.com/office/7800supplies).

**General Paper Loading Guidelines**

- Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
- Do not print on label media once a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.
- Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
- Adjust the paper guides to fit the paper size.
- Fan paper before loading it in the paper tray.
- If excessive jams occur, use paper or other approved media from a new package.
Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

⚠️ **CAUTION:** The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
- Avoid food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
- Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.
Advanced Finisher Guidelines

- Right tray capacity: 2000 sheets
- Supported paper sizes: From 182 x 210 mm (7.2 x 8.6 in.) through 297 x 432 mm (11.7 x 17 in.)
- Supported paper weights: 75–256 g/m²
- Stapling options: One or two staples. Auto Stapling can staple up to 50 sheets of 75–256 g/m² paper.
- Stapling supports paper sizes from 203 x 182 mm (8 x 7.2 in.) through 297 x 432 mm (11.7 x 17 in.).
- The finisher cannot staple transparencies, labels, envelopes, heavyweight cardstock, extra heavyweight cardstock, heavyweight glossy cardstock, or extra heavyweight glossy cardstock.
- To use the stapling options, load JIS B5 and Executive long-edge feed.
- Hole Punch: Two or three hole punch available in 110V printer configuration. Two or four hole punch available in 220V printer configuration.
- Booklet Maker capacity: Crease and staple up to 15 sheets of 90 g/m² (24 lb. Bond Paper). The first sheet can be up to 256 g/m² (94 lb. Cover).
- Booklet Maker supports paper sizes from 210 x 279.4 mm (8.2 x 11 in.) through 297 x 432 mm (11.7 x 17 in.).
- To use the Booklet Maker, load all paper sizes short-edge feed.

Professional Finisher Guidelines

- Right top tray capacity: 500 sheets
- Right middle tray capacity: 1500 sheets
- Right top tray supports paper sizes from 182 x 182 mm (7.2 x 7.2 in.) through 330.2 x 488 mm (13 x 19.2 in.).
- Right middle tray supports paper sizes from 203 x 182 mm (8 x 7.2 in.) through 330.2 x 488 mm (13 x 19.2 in.).
- Right top tray supported paper weights: 75–350 g/m²
- Right middle tray supported paper weights: 75–256 g/m²
- Stapling options: One, two, or four staples. Auto Stapling can staple up to 50 sheets of 75–256 g/m² paper.
- One or two staple options support paper sizes from 203 x 182 mm (8 x 7.2 in.) through 297 x 432 mm (11.7 x 17 in.).
- The finisher cannot staple transparencies, labels, envelopes, heavyweight cardstock, extra heavyweight cardstock, heavyweight glossy cardstock, or extra heavyweight glossy cardstock.
- To use the stapling options, load JIS B5 and Executive long-edge feed. For four staples, load A4 or Letter sizes long-edge feed.
- Hole Punch: Two or three hole punch available in 110V printer configuration. Two or four hole punch available in 220V printer configuration.
- Booklet Maker capacity: Fold and staple up to 15 sheets of 90 g/m² (24 lb. Bond Paper). The first sheet can be up to 256 g/m² (94 lb. Cover).
- Booklet Maker supports paper sizes from 210 x 279.4 mm (8.2 x 11 in.) through 330.2 x 457.2 mm (13 x 18 in.).
- To use the Booklet Maker, load all paper sizes short-edge feed.
### Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Types and Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trays 1–5, 1-sided or 2-sided printing</td>
<td>Plain, Hole Punched, Letterhead, Pre-Printed, Recycled, and Custom (75–105 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Lightweight Cardstock (106–169 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Cardstock (170–256 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Lightweight Glossy Cardstock (106–169 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Glossy Cardstock (170–256 g/m²)</td>
</tr>
<tr>
<td>Tray 1, 1-sided printing</td>
<td>heavyweight Cardstock (257–300 g/m²)</td>
</tr>
<tr>
<td></td>
<td>heavyweight Glossy Cardstock (257–300 g/m²)</td>
</tr>
<tr>
<td></td>
<td>extra Heavyweight Cardstock (301–350 g/m²)</td>
</tr>
<tr>
<td></td>
<td>extra Heavyweight Glossy Cardstock (301–350 g/m²)</td>
</tr>
<tr>
<td>Trays 1–5, 1-sided printing</td>
<td>labels (106–169 g/m²)</td>
</tr>
<tr>
<td>Trays 1 and 2, 1-sided printing</td>
<td>Transparency</td>
</tr>
<tr>
<td>Tray 1, 2-sided printing, with optional Extra Heavy Duty Media Kit installed</td>
<td>heavyweight Cardstock (257–300 g/m²)</td>
</tr>
<tr>
<td></td>
<td>heavyweight Glossy Cardstock (257–300 g/m²)</td>
</tr>
</tbody>
</table>

**Note:** To print a list of supported paper and other media, at the control panel, touch **Printer** > **Print Reference Materials** > **Paper Tips** > **Print**.

### Supported Standard Paper Sizes for Phaser 7800DN and 7800GX Color Printers

<table>
<thead>
<tr>
<th>Tray Number</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All trays</td>
<td>A3 (297 x 420 mm, 11.7 x 16.5 in.)</td>
<td>Statement (140 x 216 mm, 5.5 x 8.5 in.)</td>
</tr>
<tr>
<td></td>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
<tr>
<td></td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>JIS B4 (257 x 364 mm, 10.1 x 14.3 in.)</td>
<td>216 x 330 mm, 8.5 x 13 in.</td>
</tr>
<tr>
<td></td>
<td>JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tabloid (279 x 432 mm, 11 x 17 in.)</td>
</tr>
<tr>
<td>Tray 1</td>
<td>C4 envelope (324 x 229 mm, 12.8 x 9 in.)</td>
<td>Monarch envelope (98 x 190 mm, 3.875 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>CS envelope (162 x 229 mm, 6.4 x 9 in.)</td>
<td>No. 10 envelope (241 x 105 mm, 4.125 x 9.5 in.)</td>
</tr>
<tr>
<td></td>
<td>C6 envelope (114 x 162 mm, 4.5 x 6.38 in.)</td>
<td>A7 envelope (133 x 184 mm, 5.25 x 7.25 in.)</td>
</tr>
<tr>
<td></td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
<td>152 x 228 mm, 6 x 9 in. envelope</td>
</tr>
<tr>
<td></td>
<td>A6 (105 x 148 mm, 4.1 x 5.8 in.)</td>
<td>Postcard (101.6 x 152.4 mm, 4 x 6 in.)</td>
</tr>
<tr>
<td></td>
<td>ISO B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>127 x 178 mm, 5 x 7 in.</td>
</tr>
<tr>
<td>Trays 1 and 3–5</td>
<td>SRA3 (320 x 450 mm, 12.6 x 17.7 in.)</td>
<td>305 x 457 mm, 12 x 18 in.</td>
</tr>
</tbody>
</table>
Supported Standard Paper Sizes for the Phaser 7800DX Color Printer

<table>
<thead>
<tr>
<th>Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All trays</td>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
<tr>
<td></td>
<td>JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td>Tray 1</td>
<td>C4 envelope (324 x 229 mm, 12.8 x 9 in.)</td>
<td>Monarch envelope (98 x 190 mm, 3.875 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>C5 envelope (162 x 229 mm, 6.4 x 9 in.)</td>
<td>No. 10 envelope (241 x 105 mm, 4.125 x 9.5 in.)</td>
</tr>
<tr>
<td></td>
<td>C6 envelope (114 x 162 mm, 4.5 x 6.38 in.)</td>
<td>A7 envelope (133 x 184 mm, 5.25 x 7.25 in.)</td>
</tr>
<tr>
<td></td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
<td>152 x 228 mm, 6 x 9 in. envelope</td>
</tr>
<tr>
<td></td>
<td>A6 (105 x 148 mm, 4.1 x 5.8 in.)</td>
<td>Postcard (101.6 x 152.4 mm, 4 x 6 in.)</td>
</tr>
<tr>
<td></td>
<td>ISO B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>127 x 178 mm, 5 x 7 in.</td>
</tr>
<tr>
<td>Trays 1–3</td>
<td>JIS B4 (257 x 364 mm, 10.1 x 14.3 in.)</td>
<td>Statement (140 x 216 mm, 5.5 x 8.5 in.)</td>
</tr>
<tr>
<td></td>
<td>A3 (297 x 420 mm, 11.7 x 16.5 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>216 x 330 mm, 8.5 x 13 in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tabloid (279 x 432 mm, 11 x 17 in.)</td>
</tr>
<tr>
<td>Trays 1, 3</td>
<td>SRA3 (320 x 450 mm, 12.6 x 17.7 in.)</td>
<td>305 x 457 mm, 12 x 18 in.</td>
</tr>
</tbody>
</table>

Supported Paper Sizes and Weights for Automatic 2-Sided Printing

| Minimum       |Maximum
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>128 x 140 mm (5 x 5.5 in.)</td>
</tr>
<tr>
<td></td>
<td>322 x 457 mm (12.6 x 18 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>75 g/m²</td>
</tr>
<tr>
<td></td>
<td>256 g/m² Note: Maximum weight is 300 g/m² with the optional upgrade kit installed.</td>
</tr>
</tbody>
</table>

Supported Custom Paper Sizes

<table>
<thead>
<tr>
<th>Tray Number</th>
<th>Paper Sizes, Minimum–Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Width: 89–320 mm (3.5–12.6 in.) Length: 99–1219 mm (3.9–48 in.)</td>
</tr>
<tr>
<td>Tray 2</td>
<td>Width: 140–297 mm (5.5–11.7 in.) Length: 182–431 mm (7.2–17 in.)</td>
</tr>
<tr>
<td>Phaser 7800GX Color Printer Trays 3–5</td>
<td>Width: 140–330 mm (5.5–13 in.) Length: 182–457 mm (7.2–18 in.)</td>
</tr>
<tr>
<td>Phaser 7800DX Color Printer Tray 3</td>
<td></td>
</tr>
</tbody>
</table>
Loading Paper

This section includes:
- Loading Paper in Tray 1 ................................................................. 41
- Loading Paper in Trays 2–5 ............................................................... 44
- Setting the Guide Locks in the 500-Sheet Adjustable Trays ........... 49
- Changing Paper Size, Type, and Color ........................................... 51

Loading Paper in Tray 1

1. Open Tray 1 and remove any paper that is a different size or type.

2. Pull out the extension tray for larger sizes.
3. Move the width guides to the edges of the tray.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

5. Load the paper in the tray. Do one of the following:
   - For long-edge feed 1-sided printing, insert letterhead, pre-printed paper, and labels face down with the top edge toward the front. Load hole punched paper with the holes to the left.
• For long-edge feed 2-sided printing, insert letterhead and pre-printed paper face up with the top edge toward the front. Load hole punched paper with the holes to the right.

• For short-edge feed 1-sided printing, insert letterhead, pre-printed paper, and labels face down with the bottom edge leading into the printer. Load hole punched paper with the holes toward the back.

• For short-edge feed 2-sided printing, insert letterhead and pre-printed paper face up with the top edge leading into the printer. Load hole punched paper with the holes toward the back.

**Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
6. Adjust the width guides until they touch the edges of the paper.

7. If the control panel prompts you, verify the size, type, and color information on the Tray Settings screen.
   a. Touch Size, Type, or Color, then modify the settings as needed.
   b. Touch OK.

   Note: For more information on changing paper size, type and color, see Changing Paper Size, Type, and Color on page 51.
Loading Paper in Trays 2–5

1. Pull out the tray until it stops.

2. Ensure that the guide locks are set in the correct position for the standard or custom size paper you are loading. For details, see Setting the Guide Locks in the 500-Sheet Adjustable Trays on page 49.

3. Remove any paper that is a different size or type.

4. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

6. Load the paper in the tray. Do one of the following:
   - For long-edge feed 1-sided printing, insert letterhead, pre-printed paper, and labels face up with the top edge toward the front. Load hole punched paper with the holes to the right.

   ![Image of paper loading](image1)

   - For long-edge feed 2-sided printing, insert letterhead and pre-printed paper face down with the top edge toward the front. Load hole punched paper with the holes to the left.

   ![Image of paper loading](image2)
• For short-edge feed 1-sided printing, insert letterhead, pre-printed paper, and labels face up with the top edge toward the right. Load hole punched paper with the holes toward the back.

• For short-edge feed 2-sided printing, insert letterhead and pre-printed paper face down with the top edge toward the left. Load hole punched paper with the holes toward the back.

Notes:
• You cannot load paper short-edge feed in Trays 4 and 5 using the 2500-Sheet Feeder.
• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
7. Adjust the length and width guides to fit the paper.

8. Close the tray.

9. If the control panel prompts you, verify the size, type, and color information on the Tray Settings screen.
   a. Touch Size, Type, or Color, then modify the settings as needed.
   b. Touch OK.

   Note: For more information on changing paper size, type and color, see Changing Paper Size, Type, and Color on page 51.
Setting the Guide Locks in the 500-Sheet Adjustable Trays

You can adjust the guides in Trays 2–5 to accommodate standard or custom paper sizes. In the standard position, the guides move into the supported standard paper settings. In the custom position, the guides move in 1 mm increments.

To move the guide locks from the standard to the custom paper size position, do the following:

1. Pull out the tray until it stops.

Note: For best results, remove any paper from the tray, pinch the guide levers, and slide the guides inward.

2. Pry up the retainer with your fingertip, pulling the lower edge toward you.

3. To engage the fine-adjustment block, pinch the levers and slide the guide lock to the left as shown.
4. Replace the retainer and snap it into place.

5. Load the custom-size paper in the tray. The tray guides move in increments of 1 mm.

To move the guide locks from the Custom to the Standard paper size position, do the following:

1. Pull out the tray until it stops.

   **Note:** For best results, remove any paper from the tray, pinch the guide levers, and slide the guides inward.

2. Pry up the retainer with your fingertip, pulling the lower edge toward you.
3. To release the fine-adjustment block, pinch the levers and slide the guide lock to the right as shown.

4. Replace the retainer and snap it into place.

5. Load the standard size paper in the tray. The tray guides move to the standard paper size positions.
Changing Paper Size, Type, and Color

When Tray 1 is set to Bypass or Fully Adjustable mode, you can change paper settings each time you load the tray. When you load paper into an empty tray, the control panel prompts you to set the paper size, type, and color.

When Trays 2–5 are set to Fully Adjustable mode, open the selected tray and load the desired paper. When you close the tray, the control panel prompts you to set the paper size, type, and color.

When a paper tray is set to Dedicated mode, the control panel does not prompt you when you load paper. If you move the guides to load a different paper size in Trays 2–5, the control panel displays an error message. Once you load the new paper, change the size, type, and color of paper at the control panel.

To set the paper size, type, or color for a dedicated tray:
1. At the control panel, touch Printer.
2. Touch the Tools tab, then touch Tray Management.
3. Touch Tray Settings, then select a dedicated tray.
4. To modify the tray settings, touch Edit.
5. Select Size, Type, or Color.
6. Scroll through the list as needed, and touch the desired paper setting.
7. Touch OK.
8. To save the setting, touch OK.

Note: To access the Tray Management menu, you can be required to log in as the system administrator. For details, see the System Administrator Guide at www.xerox.com/office/7800docs.
Printing on Special Paper

This section includes:

- Envelopes ................................................................. 53
- Labels ........................................................................ 55
- Glossy Cardstock ..................................................... 55
- Transparencies .......................................................... 56

To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/office/7800supplies.

See also:

  www.xerox.com/paper Recommended Media List (United States)
  www.xerox.com/europaper Recommended Media List (Europe)

Envelopes

You can print envelopes from Tray 1.

Guidelines for Printing Envelopes

- Print quality depends on the quality and construction of the envelopes. Try another envelope brand if you do not get desired results.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid the excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat activated glue.
- Do not use envelopes with press and seal flaps.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of them.
- In the print driver software, select Envelope as the paper type.
- Use only paper envelopes.
- Do not use envelopes with windows or metal clasps.
Loading Envelopes in Tray 1

1. Open Tray 1 and remove any paper that is a different size or type.

2. Move the width guides to the edges of the tray.

3. Load the envelopes with the flaps closed and facing down:
   - Load envelopes up to 320 mm (12.6 in.) long-edge feed, with the flaps leading into the printer.
• Load C4 and custom-size envelopes longer than 320 mm (12.6 in.) short-edge feed, with the flaps toward the back, and define a custom size on the control panel.

4. Adjust the width guides to fit the envelopes.
5. Set the paper size, type, and color on the control panel. For details, see Changing Paper Size, Type, and Color on page 51.

Labels

You can print labels from any tray.

Guidelines for Printing Labels

• Use labels designed for laser printing.
• Do not use vinyl labels.
• Do not feed a sheet of labels through the printer more than once.
• Do not use dry gum labels.
• Print only on one side of the sheet of labels. Use full sheet labels only.
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
• In the print driver software, select Label as the paper type.
• Remove all other paper from the tray before loading labels.

⚠️ CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.
Glossy Cardstock

You can print Lightweight Glossy Cardstock and Glossy Cardstock from any tray. You can print Heavyweight Glossy Cardstock and Extra Heavyweight Glossy Cardstock from Tray 1.

Guidelines for Printing on Glossy Cardstock

- Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.
- Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam in the printer.
- In the print driver software, select the desired glossy cardstock type or select the tray loaded with the desired paper.

Transparencies

You can print transparencies from Trays 1 and 2.

Guidelines for Printing on Transparencies

- Remove all paper before loading transparencies in the tray.
- Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print quality.
- Do not use transparencies with stripes on the side.
- Do not fan transparencies.
- In the print driver software, select Transparency as the paper type.
This chapter includes:

- Printing Overview ................................................................. 58
- Selecting Printing Options ...................................................... 59
- Printing Features ..................................................................... 63
Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure that you have the correct print driver software installed on your computer. For details, see Installing the Software on page 31.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

3. Access the print settings in your software application. For most software applications, press **CTRL+P** for Windows, or **CMD+P** for Macintosh.

4. Select your printer from the list.

5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® Features for Macintosh. The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click **OK**.

7. Click Print to send the job to the printer.
Selecting Printing Options

This section includes:

- **Print Driver Help** .............................................................................................................................................. 59
- **Windows Printing Options** ................................................................................................................................. 60
- **Macintosh Printing Options** .............................................................................................................................. 61

Printing options, also called print driver software options, are specified as Printing Preferences in Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality. Printing options that are set from Printing Preferences become the default setting. Printing options that are set from within the software application are temporary. The application and the computer do not save the settings after the application is closed.

**Print Driver Help**

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help button (?) in the bottom left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences settings appears in the Help window on two tabs:

- **Contents** provides a list of the tabs at the top and the areas at the bottom of the Printing Preferences window. Use the Contents tab to find explanations for each of the fields and areas in Printing Preferences.
- **Search** provides a field in which you can enter the topic or function for which you need information.
**Windows Printing Options**

**Setting Default Printing Options for Windows**

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

To select default printing options:
1. In the Windows Taskbar, click Start > Settings > Printers and Faxes.
2. In the Printers and Faxes folder, right-click the icon for your printer and click Printing Preferences.
3. Click a tab in the Printing Preferences window, select options, then click OK to save.

*Note:* For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

**Setting Printing Options for an Individual Job for Windows**

To use special printing options for a particular job, change the Printing Preferences from the application before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode when printing a particular document, select Enhanced in Printing Preferences before printing the job.

**Selecting Finishing Options for Windows**

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print driver. The finishers provide collation, folding, and stapling. A hole punch unit and booklet maker are standard on the Professional Finisher, and optional for the Advanced Finisher.

To select finishing options in the PostScript and PCL print drivers:
1. In the print driver, click the Paper/Output tab.
2. Click the arrow to the right of the Finishing section, then select the desired finishing options.
Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select the printer, then click Properties. Click the tabs in the Printing Properties window and select the desired settings.
3. Click Saved Settings at the bottom of the Printing Properties window, then click Save As.
4. Type a name for the set of printing options, then click OK to save the set of options in the Saved Settings list.
5. Select the name from the list to print using these options.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.
2. Select your printer from the list.
3. Select Xerox® Features from the Copies & Pages menu.
4. Select the desired printing options from the drop-down lists.
5. Click Print to send the job to the printer.

Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print driver. You can staple up to 50 sheets of 90 g/m² paper, and offset and stack up to 1000 sheets.

To select stapling in the Macintosh print driver:
1. In the print driver, click Copies & Pages, then select Xerox® Features.
2. In the Paper/Output dialog box, click the arrow to the right of the Finisher section, then select 1 Staple.

To select offsetting in the Macintosh print driver:
1. In the print driver, click Copies & Pages, then select Xerox® Features.
2. On the Advanced tab, select Request Offset.
3. Click the arrow to the right of the field and select Offset Each Set.
Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the desired printing options from the drop-down lists in the Print dialog box.
4. Click Presets > Save As.
5. Type a name for the printing options, then click OK to save the set of options in the Presets list.
6. To print using these options, select the name from the Presets list.
Printing Features

This section includes:

- Printing on Both Sides of the Paper ................................................................. 63
- Selecting Paper Options for Printing ............................................................. 64
- Printing Multiple Pages to a Single Sheet (N-Up) ..................................................... 64
- Printing Booklets .................................................................................................. 64
- Using Color Options ............................................................................................... 65
- Printing Covers ....................................................................................................... 66
- Printing Inserts ......................................................................................................... 67
- Printing Exception Pages ......................................................................................... 67
- Scaling ..................................................................................................................... 68
- Printing Watermarks ............................................................................................... 69
- Printing Mirror Images ........................................................................................... 70
- Creating and Saving Custom Paper Sizes .............................................................. 70
- Selecting Job Completion Notification for Windows ............................................... 71
- Printing Special Job Types ...................................................................................... 71

Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.
Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet (N-Up)

When printing a multiple-page document, you can print more than one page on a single sheet of paper. Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet (N-Up) on the Layout/Watermark tab.
Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any paper size that is supported for 2-sided printing. The driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter** specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep** specifies how much the page images are shifted outward, in tenths of a point. Shifting compensates for the thickness of the folded paper, which would cause the page images to shift slightly outward when folded. You can select a value from zero to 1 point.
Using Color Options

The Color Options control the way the printer uses color to produce your document. The Windows PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each system has three standard modes of color control for normal use and Custom Color Options for the more advanced users.

The three standard color modes are:

- **Automatic Color** applies the best color correction to text, graphics, and images. This setting is recommended.
- **Vivid Color** applies automatic color correction to make office colors more saturated.
- **Black and White** converts all color in the document to black and white or shades of gray.

Custom Color Options provide three ways of adjusting the colors for more specific color requirements. Click the Custom Color Options bar to open the Custom Color Options window:

- **Color By Words** provides a three step process for defining custom color correction. By making a selection from each of the three fields, you create a sentence for controlling the color characteristics of the document. You can create several sentences to more precisely control the color content of the document.
  
  The sentence structure is made of three parts:
  
  - **What Color to Change?** provides a drop-down list to select a color or range of colors to adjust, such as All Foliage-Green Colors.
  - **How Much Change?** lets you select how much effect to make, such as A Lot More, to the selected color.
  - **What Type of Change?** lets you select the type of change, such as Vivid, from the drop-down list.

  As you create a Color By Words sentence, it appears in the window below the selection fields.

- **Color Correction** provides a list of commercial press, spot color, CIE, and gray image simulations from which you can select to match your document color.

- **Color Adjustments** provides a set of six sliders for adjusting the individual components of the selected colors. Use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and yellow components of the color.
Printing Covers

A cover is the first or last page of a document. You can select paper sources for the covers that are different from the source used for the body of a document. For example, you can use your company letterhead for the first page of a document. You can also use heavyweight paper for the first and last pages of a report. You can use any applicable paper tray as the source for printing covers.

Select an option for printing covers:
- **No Covers** cancels any previous Covers settings.
- **Front Only** prints the first page on paper from the specified tray. With automatic 2-sided printing, the first two pages print on the cover.
- **Back Only** prints the back page on paper from the specified tray. With automatic 2-sided printing, the last two pages print on the cover when the page count is even.
- **Front and Back: Same** prints the front and back covers from the same tray.
- **Front and Back: Different** prints the front and back covers from different trays.

Printing Inserts

You can add blank or pre-printed inserts before page one of each document or after designated pages within a document. Adding an insert after designated pages within a document separates sections, or acts as a marker or placeholder. Make sure that you specify the paper to use for the inserts.

Modify these settings when printing inserts:
- **Insert Options** provides the options to place an insert After Page X, where X is the specified page, or Before Page 1.
- **Insert Quantity** specifies the number of pages to insert at each location.
- **Page(s)** specifies a page or a range of pages after which you want an insert added. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to add inserts after pages 1, 6, 9, 10, and 11, type: 1, 6, 9-11.
- **Paper** displays the default size, color, and type of paper selected in Use Job Settings for the inserts. Use the Down Arrow to the right of the Paper field to select a different paper size, color, or type.
- **Job Settings** displays the attributes of the paper for the remainder of the job.
Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences such as page size, page type, and page color. You can also change the side of the paper on which to print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the alternate paper source:

- **Page(s)** specifies the page or range of pages that use the exception page characteristics. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type 1,6-9,11.

- **Paper** displays the default size, color, and type of paper selected in Use Job Settings. Click the Down Arrow to the right of the Paper field to select a different paper size, color, or type.

- **2-Sided Printing** allows you to select 2-sided printing options. Click the Down Arrow to select an option:
  - **1-Sided Print** prints the exception pages on one side only.
  - **2-Sided Print** prints the exception pages on both sides of the paper and flips the pages on the long edge. The job can then be bound on the long edge of the pages.
  - **2-Sided Print, Flip on Short Edge** prints the exception pages on both sides of the paper and flips the pages on the short edge. The job can then be bound on the short edge of the pages.

- **Job Settings** displays the attributes of the paper for the remainder of the job.

**Notes:**

- If your printer does not support automatic 2-sided printing, not all of the options are available.
- Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected results.
Scaling

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. The default setting is 100%.

<table>
<thead>
<tr>
<th>50%</th>
<th>100%</th>
<th>200%</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="50% Image" /></td>
<td><img src="image2" alt="100% Image" /></td>
<td><img src="image3" alt="200% Image" /></td>
</tr>
</tbody>
</table>

In Windows, the Scale Options are located in the print driver on the Paper/Output tab in the Paper field. Click the arrow at the right side of the Paper field and select Other Size to access the Scale Options:

- **No Scaling** does not increase or decrease the size of the image from the original.
- **Automatic Scaling** changes the print from one standard paper size to another standard paper size. The Original Document Size is scaled to fit on the selected output paper size shown in the Output Paper Size field.
- **Manual Scaling** changes the output print size by the percentage entered into the field under the graphic to the right of the Scale Options.
Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

Using the watermark options, you can do the following:
- Create a watermark or edit an existing watermark using the Watermark Editor:
  - **Name** allows you to give the new watermark a unique name.
  - **Options** enables you to use text, time stamps, or graphics for the watermark.
  - **Text** provides a field in which you enter the text to be printed as the watermark.
  - **Font** and **Color** determine the font, size, style, and color of the watermark.
  - **Angle** sets the degree of rotation applied to the text or graphics used for the watermark.
  - **Density** defines how faint or how prominent the watermark appears on the pages.
  - **Position from center** determines the position of the watermark on the page. The default position is in the center of the printed pages.
- Place a watermark on the first page or on every page in a document.
- Print a watermark in the foreground or background or blend it with the print job.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.
Creating and Saving Custom Paper Sizes

You can print custom-size paper from Trays 1–6. Custom size paper settings are saved in the print driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, see Supported Custom Paper Sizes on page 40.

To create and save custom sizes for Windows:
1. Click the Paper/Output tab of the print driver.
2. Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New.
3. In the New Custom Size window, enter the height and width of the new size, then select the units.
4. Enter a title for the new size in the Name field, then click OK to save.

To create and save custom sizes for Macintosh:
1. In the application, click File > Page Setup.
2. Click Paper Sizes, then select Manage Paper Sizes.
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
4. Double-click Untitled at the top of the window and type a name for the new custom size.
5. Enter the height and width of the new custom size.
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set the top, bottom, right, and left margins for User Defined margins.
7. To save the settings, click OK.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification:
1. In the print driver, click More Status at the bottom of any tab.
2. In the Status window, click Notification, then click the desired option.
3. Close the Status window.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control panel. Select special job types in the Printing Preferences of the print driver.
**Sample Set**

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the remaining copies at the printer. After you review the sample copy, you can select the job name from the printer control panel to print the additional copies.

To release the remainder of prints after printing a sample set:
1. At the control panel, touch Jobs.
2. Touch the corresponding print job in the list.
   - **Note:** The control panel displays Held: Sample Set next to the job name.
3. Touch Release.
   - The remainder of the job prints, and the job is deleted from the printer hard drive.

**Secure Print**

Secure Print allows you to associate a 4–10 digit passcode number with a print job when sending it to the printer. The job is held at the printer until the same passcode is entered at the control panel.

To release a Secure Print job for printing:
1. At the control panel, touch Jobs.
2. Touch Personal and Secure Jobs.
3. Touch your assigned private folder.
4. Type the passcode assigned to the job, then touch OK.
5. Touch the corresponding print job in the list.
6. Touch Print.
   - The job prints, then is deleted from the printer hard drive.

**Saved Job**

Saved Job allows you to save a print job to a folder on the printer. Using the controls in the Saved Jobs window, you can save the job, or you can print and save the job for future use. You can also set the access to the print job as follows:
- **Public** requires no passcode and allows any user to print the file from the control panel of the printer.
- **Private** requires a passcode so that only a user with the passcode can print the file.

When the Saved Job is no longer needed, you can delete it from the control panel of the printer.

To print a public saved job:
1. At the control panel, touch Jobs.
2. Touch Saved Jobs.
3. Touch Public.
4. Touch Quantity to enter the number of copies, then touch OK.
5. Touch the name of the desired print job.
6. To submit the print job, touch Print.
   The job prints, and remains on the printer hard drive for future use.

To print a private saved job:
1. At the control panel, touch Jobs.
2. Touch Saved Jobs.
3. Touch your assigned private folder.
4. Type the passcode assigned to the job, then touch OK.
   The screen shows a list of saved print jobs that use that passcode.
5. Touch Quantity to enter the number of copies, then touch OK.
6. Touch the name of the desired print job.
7. To submit the print job, touch Print.
   The job prints, and remains on the printer hard drive for future use.

**Personal Print**

Personal Print allows you to store a document in the printer, then print it from the control panel.

To print a personal job:
1. At the control panel, touch Jobs.
2. Touch Personal and Secure Jobs.
3. Touch your assigned private folder.
4. Touch the corresponding print job in the list.
5. Touch Print.
   The job prints, then is deleted from the printer hard drive.

*Note:* You can also print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
This chapter includes:

- **General Precautions** ................................................................. 76
- **Cleaning the Printer** ................................................................. 77
- **Routine Maintenance** ............................................................... 84
- **Billing and Usage Information** ................................................... 94
- **Ordering Supplies** ................................................................. 95
- **Moving the Printer** ................................................................. 98
General Precautions

⚠️ **CAUTION:** When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation.

⚠️ **WARNING:** Keep all cleaning materials out of the reach of children.

⚠️ **WARNING:** Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners increases the risk of fire and explosion.

⚠️ **WARNING:** Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

⚠️ **WARNING:** Internal parts of the printer can be hot. Use caution when doors and covers are open.

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the imaging units.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure any parts removed during cleaning are replaced before you plug in the printer.
Cleaning the Printer

This section includes:
- Cleaning the Printer Exterior ................................................................. 77
- Cleaning the Printer Interior ................................................................. 78

Cleaning the Printer Exterior

Regular cleaning keeps the touch screen and control panel free from dust and dirt.

To clean the printer exterior:
1. To avoid activating buttons and menus, press the Power Saver button.

2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft, lint-free cloth.
3. To return the printer to Ready mode, press the Power Saver button.
4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas of your printer.

Cleaning the Printer Interior

Cleaning the Printhead Lenses

The printer is constructed with four printhead lenses. Clean all lenses as described in the following procedure.

⚠️ CAUTION: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.

2. Turn the orange lever to the left.
3. Pull the drum cartridge cover down until it clicks into the open position.

4. Each of the four printheads has its own cleaning tool. Slowly pull the printhead lens cleaner out until the three dots are visible.

   Note: The printhead lens cleaner does not detach from the printer.

5. Slowly push the printhead lens cleaner back into the printhead until it stops.

6. Repeat Steps 4 and 5 for each printhead.

7. Close the drum cartridge cover.
8. Turn the orange lever to the right to return it to the locked position.

9. Close the printer front cover.

**Cleaning the Feed Rollers**

Periodically inspect the feed rollers in each of the installed trays, and clean them if paper dust or other residue is visible. Dirt on the feed rollers can cause paper jams or deteriorate print quality.

1. Pull out the tray until it stops.

2. Tilt the tray upward, and pull to remove it.

*Note: Trays 4 and 5 in the 2500-sheet feeder cannot be removed.*
3. Locate the feed rollers in the tray.

4. Slide the feed roller cover toward the front of printer.

5. Turn each feed roller until the roller hook is visible.

6. Pull each feed roller hook out of the groove on the axle.

7. Slide the feed rollers to the front and remove them, one at a time.
8. Wipe the rollers with a clean, lint-free cloth moistened with water.
9. Align the hole of the first feed roller with the axle.

10. Slide the feed roller along the axle until the protrusions fit completely into the slots, and the roller hook reseats into the groove.

11. Install the second and third feed rollers using a similar method.
12. Slide the feed roller cover back into the printer.
13. Reinsert the tray at an angle.

14. Slide the tray back into the printer.

15. Repeat for all of the installed trays.
Routine Maintenance

This section includes:

- Replacing Staple Cartridges ................................................................. 84
- Emptying the Hole Punch Waste Container ............................................. 91

For information on ordering supplies, see Ordering Supplies on page 95.

Replacing Staple Cartridges

A message appears on the control panel when a staple cartridge is empty.

Replacing Staples in the Booklet Maker of the Advanced Finisher

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide them to the center.
3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.

4. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in the finisher.

   **Note:** If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the cartridge.

   **Note:** The Booklet Maker uses two staple cartridges. Booklet stapling requires that both staple cartridges contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the finisher side cover.

**Replacing Staples in the Main Stapler of the Professional Finisher**

1. Open the finisher front door.
2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. Check inside the finisher for any loose staples and remove them.

4. Pinch both sides of the staple pack (1) and remove the staple pack from the cartridge (2).

5. Insert the front side of the new staple pack into the staple cartridge (1), then push the rear side into the cartridge (2).
6. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until it clicks.

7. Close the finisher front door.

**Replacing Staples in the Booklet Maker of the Professional Finisher**

1. Open the finisher front door.

2. While squeezing the orange levers R2 and R3 together (1), pull the stapler assembly out of the finisher until it stops (2).

   **Note:** The stapler assembly does not detach from the finisher.
3. Grip the orange tabs on both sides of the staple cartridge.

4. While gripping the orange tabs of the staple cartridge, rotate it in the direction shown.

5. Lift the staple cartridge out of the stapler unit.

6. Push the new staple cartridge into the stapler unit until it clicks.
7. If you find no jammed staples, repeat the preceding steps for the other staple cartridge.
8. Push the stapler assembly until it clicks into its original position.

9. Close the finisher front door.

Replacing Staples in the Main Stapler of the Advanced Finisher

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
3. Push the stapler assembly to the right as shown.
4. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. Check inside the finisher for any loose staples and remove them.

5. Pinch both sides of the staple pack (1) and remove the staple pack from the cartridge (2).

6. Insert the front side of the new staple pack into the staple cartridge (1), then push the rear side into the cartridge (2).

7. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until it clicks.

8. Close the finisher front door.
Emptying the Hole Punch Waste Container

A message appears on the control panel when the hole punch waste container is full.

Emptying the Hole Punch Waste Container in the Professional Finisher

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Pull out the waste container at R4.

3. Empty the container.
4. Insert the container all the way into the finisher.

5. Close the finisher front door.

**Emptying the Hole Punch Waste Container in the Advanced Finisher**

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Lift the finisher transport top cover, then open the front transport cover.

2. Pull out the hole punch waste container.
3. Empty the container.

4. Insert the container all the way into the finisher.

5. Close the finisher front transport cover, then close the top cover.
Billing and Usage Information

Billing and printer usage information appears on the Billing Meters information screen. The impression counts shown are used for billing.

To view Billing and Usage information:

1. At the control panel, touch Printer.
2. To view basic impression counts on the Information tab, touch Billing Meters.
   - Color Impressions: Total number of pages printed that specify color.
   - Black Impressions: Total number of pages printed with no color specified.
   - Total Impressions: Total number of color impressions plus black impressions.
3. To view impression counts for large paper, scroll to the next screen.
   - Color Large Impressions: Number of large pages printed that specify color.
   - Black Large Impressions: Number of large pages printed with no color specified.
   - Total Large Impressions: Total number of large color impressions plus black impressions.

   Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed on two sides counts as two impressions.

4. To view detailed usage information, touch Usage Counters.
5. Touch one of the following:
   - Print allows you to print Billing Meters or Supplies Usage pages.
   - Back returns to the Billing Meters screen.
   - Home returns to the main screen.
Ordering Supplies

This section includes:

- Locating the Serial Number ................................................................. 95
- Consumables ................................................................................. 95
- Routine Maintenance Items ......................................................... 95
- Customer Replaceable Units ....................................................... 96
- Other Supplies ............................................................................... 96
- When to Order Supplies ................................................................. 96
- Viewing Printer Supply Status ................................................... 97
- Recycling Supplies ..................................................................... 97

Locating the Serial Number

You need the printer serial number to order supplies or to contact Xerox for assistance. The serial number is on the left front side of the printer, behind Left Side Door A. You can also view the serial number on the control panel.

To view the serial number on the control panel:

1. At the control panel, touch Printer.
2. On the Information tab, touch About This Printer.
   The General tab displays the model, serial number, version, and activation date.

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.

Note: Each consumable includes installation instructions.

⚠️ CAUTION: Use of toner other than Genuine Xerox® Toner can affect print quality and printer reliability. It is the only toner designed and manufactured under strict quality controls by Xerox for specific use with this printer.
Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Routine maintenance items for this printer include the following:
- Imaging Units (Cyan, Magenta, Yellow, and Black)
- Belt Cleaner
- Suction Filter
- Waste Cartridge

*Note:* Each routine maintenance item includes installation instructions.

Customer Replaceable Units

Customer replaceable units (CRUs) are printer parts that can be replaced without need for technical service intervention. These parts have longer rated lives than routine maintenance items.

Customer Replaceable Units for this printer include the following:
- 110 V Fuser for the Phaser 7800 Color Printer
- 220 V Fuser for the Phaser 7800 Color Printer
- Feed Roller Kit
- Transfer Roller

*Note:* Each customer replaceable unit includes installation instructions.

Other Supplies

Other supplies are items required for options on certain printer configurations or accessories but are not required for daily use.

Other supplies for this printer include the following:
- Staple Refills for the Advanced Finisher and Professional Finisher
- Staple Cartridge for the Advanced Finisher and Professional Finisher
- Staple Cartridge for the Advanced Finisher Booklet Maker
- Staple Cartridge for the Professional Finisher Booklet Maker
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/7800supplies.

⚠️ CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.

Viewing Printer Supply Status

You can check the status of printer supplies at any time.

1. To view basic information about toner cartridges, do one of the following:
   - At the control panel, touch Printer, then touch the Supplies tab.
   - Touch one of the C, M, Y, K icons in the lower right of the main screen.
2. To view details about a specific cartridge, including the part number for reordering, touch C, M, Y, or K.
3. To return to the Supplies tab, touch Close.
4. To view more details, touch Other Supplies. Scroll through the list, then select one of the following:
   - Fuser
   - Belt Cleaner
   - Transfer Roller
   - Waste Cartridge
   - Imaging Units
   - Transfer Belt
   - Suction Filter
   - Feed Rollers
   - Staple Cartridge
5. To return to the Other Supplies screen, touch the Back Arrow.
6. To print the Supplies Usage page, touch the Print icon, then touch Supplies Usage.
7. To return to the main screen, touch Home.

Recycling Supplies

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

Supplies include a prepaid return label. Please use it to return used components in their original boxes for recycling.
Moving the Printer

- Always use at least three people to lift the printer.
- Always turn off the printer and wait for the printer to shut down.
- Disconnect the power cord from the back of the printer.
- When lifting the printer, grasp the areas as shown.
- Keep the printer level to avoid toner spillage.

**Note:** When moving the printer over a long distance, remove the imaging units and toner cartridges to prevent toner from spilling. Pack the printer inside a box. For a repacking kit and instructions, go to [www.xerox.com/office/7800support](http://www.xerox.com/office/7800support).

**CAUTION:** Failure to repackage the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
This chapter includes:

- General Troubleshooting
- Jams
- Print-Quality Problems
- Getting Help
General Troubleshooting

This section includes:

- Printer Does Not Turn On ................................................................. 100
- Printer Resets or Turns Off Frequently ............................................. 101
- Printing Takes Too Long ................................................................. 101
- Document Prints From Wrong Tray .................................................. 101
- Document Fails to Print ................................................................. 101
- Printer is Making Unusual Noises .................................................. 102
- Automatic 2-Sided Printing Problems ............................................. 102
- Date and Time Are Incorrect ............................................................ 103

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Printer Does Not Turn On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the power switches is not turned on.</td>
<td>Turn off both of the power switches. The Main Power switch is behind the front door and the Secondary Power switch is on the top of the printer. Wait two minutes, then turn on both of the switches. For details, see Turning the Printer On and Off on page 28.</td>
</tr>
<tr>
<td>The power cord is not correctly plugged into the outlet.</td>
<td>Turn off the printer power switch, and plug the power cord securely into the outlet. For details, see Turning the Printer On and Off on page 28.</td>
</tr>
</tbody>
</table>
| Something is wrong with the outlet connected to the printer. | • Plug another electrical appliance into the outlet and see if it operates properly.  
  • Try a different outlet. |
| The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications. | Use a power source with the specifications listed in the Electrical Specifications on page 166. |

⚠️ **CAUTION:** Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
Printer Resets or Turns Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power cord is not correctly plugged into the outlet.</td>
<td>Turn off the printer, confirm that the power cord is correctly plugged into the printer and the outlet, then turn on the printer. For details, see Turning the Printer On and Off on page 28.</td>
</tr>
<tr>
<td>The printer is plugged into an Uninterruptible Power Supply (UPS), extension cord, or power strip.</td>
<td>Only use an extension cord designed to handle the electrical current capacity of the printer.</td>
</tr>
<tr>
<td>A network configuration problem exists.</td>
<td>Unplug the network cable. If the problem is resolved, contact your network administrator to reconfigure your network installation.</td>
</tr>
<tr>
<td>A system error occurred.</td>
<td>Contact your Xerox representative with the error code and message. Check the control panel fault history. For details, see Viewing Error Messages on the Control Panel on page 152.</td>
</tr>
</tbody>
</table>

Printing Takes Too Long

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is set to a slower printing mode, for example, for printing on heavyweight paper or transparencies.</td>
<td>It takes more time to print on certain types of special media. Make sure that the paper type is set properly in the driver and at the printer control panel.</td>
</tr>
<tr>
<td>The printer is in Energy Saver mode.</td>
<td>Wait. It takes time for printing to start when the printer is coming out of Energy Saver mode.</td>
</tr>
<tr>
<td>The way the printer was installed on the network could be an issue.</td>
<td>Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds. To test the speed of the printer, print some Information pages such as the Office Demo Page. If the page does not print at the rated speed of the printer, you could have a network or printer installation issue.</td>
</tr>
<tr>
<td>The job is complex.</td>
<td>Wait. No action needed.</td>
</tr>
</tbody>
</table>

Document Prints From Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| Application and print driver have conflicting tray selections. | 1. Check the tray selected in the print driver.  
2. Go to the page setup or printer settings of the application from which you are printing.  
3. Set the paper source to match the tray selected in the print driver or set the paper source to Automatically Select.  
Note: To have the print driver select the tray, set the tray used as the paper source to Auto Selection Enabled. |
Troubleshooting

Document Fails to Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected tray has wrong paper size loaded.</td>
<td>To view the Job Status for a failed print on the touch screen: 1. At the control panel, touch Jobs. 2. Find the failed print job in the list. 3. Note the status of the failed print job, such as Held: Resources Required. 4. For details, touch the print job, then touch Job Details. 5. Note the Tray number listed under Resources and the status of the selected tray. 6. Load the correct size paper in the tray or select another tray.</td>
</tr>
<tr>
<td>Selected paper type or color is not available.</td>
<td>To view the Job Status for a failed print on the touch screen: 1. At the control panel, touch Jobs. 2. Find the failed print job in the list. 3. Note the status of the failed print job, such as Held: Resources Required. 4. For details, touch the print job, then touch Job Details. 5. Note the Tray number listed under Resources and the status of the selected tray. 6. Load the correct paper type or color in the tray, or select another tray.</td>
</tr>
<tr>
<td>Application and print driver have conflicting tray selections.</td>
<td>For details, see Document Prints from Wrong Tray on page 101.</td>
</tr>
</tbody>
</table>

Printer is Making Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the trays is not installed correctly.</td>
<td>Open and close the tray from which you are printing.</td>
</tr>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Turn off the printer and remove the obstruction or debris. If you cannot remove it, contact your Xerox® service representative.</td>
</tr>
</tbody>
</table>
Automatic 2-Sided Printing Problems

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Ensure that you are using the correct paper. For details, see Supported Paper Sizes and Weights for Automatic 2-Sided Printing on page 40. Envelopes, labels, transparencies, and paper heavier than 220 g/m² cannot be used for 2-sided printing.</td>
</tr>
</tbody>
</table>
| Incorrect setting. | • In the print driver Properties, select 2-Sided Print on the Paper/Output tab.  
• Check the settings at the printer control panel: Touch Printer > Tools > Setup > Output Settings > 2-Sided Printing. |

Date and Time Are Incorrect

The date and time are set automatically when the printer is connected to a network that has a Network Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that the internal clock of the printer stays synchronized with the NTP server you specify.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The Date and Time Setup is set to Manual (NTP Disabled). | Change the Date and Time to Automatic by enabling NTP. Enable NTP using CentreWare Internet Services:  
1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.  
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 24.  
2. Click the Properties tab.  
3. In the navigation pane, click the arrow to the left of General Setup.  
4. From the expanded General Setup menu, select Date and Time.  
5. In the Date and Time page, click the arrow at the right of the Date and Time Setup box.  
6. Select Automatic using NTP.  
7. In the NTP Server Settings, enter the IP address for the NTP server.  
8. Click Apply. |
| The time zone, date, or time is set incorrectly. | Set the time zone, date, and time manually:  
1. At the control panel, touch Printer.  
2. Touch the Tools tab, then touch Setup.  
3. Touch General Settings > Date/Time.  
4. Change information as needed:  
   a. Touch Time Zone, then use the Up and Down Arrows to select your geographic region and time zone, then touch OK.  
   b. Touch Date, then use the Left and Right Arrows to select the year, month, and day, then touch OK.  
   c. Touch Time, then touch Hour or Minutes. Use the keypad to enter the numbers, touch AM or PM, then touch OK. |
Jams

This section includes:

- Clearing Paper Jams ................................................................. 105
- Clearing Jams in the Advanced Finisher .................................... 121
- Clearing Jams in the Professional Finisher ............................... 123
- Minimizing Paper Jams ............................................................ 133
- Troubleshooting Paper Jams .................................................... 135
- Clearing Staple Jams ............................................................... 137
Clearing Paper Jams

This section includes:

- Clearing Jams at Tray 1 .......................................................... 105
- Clearing Jams at Tray 2 .......................................................... 107
- Clearing Jams at Trays 3–5 of the 1500-Sheet Feeder ...................... 109
- Clearing Jams at Trays 3–4 of the 2500-Sheet Feeder ...................... 111
- Clearing Jams at Tray 5 of the 2500-Sheet Feeder ....................... 112
- Clearing Jams at Left Side Door A .......................................... 114
- Clearing Jams in the Duplex Unit at Left Side Door B ...................... 116
- Clearing Jams in the Duplex Unit at Left Side Doors A and B .............. 117
- Clearing a Paper Size or Type Jam in Tray 1 .................................. 119

⚠️ CAUTION: To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload paper that has jammed.

Notes:

- Green handles and knobs provide access for clearing jams.
- To clear jams, watch the video and follow the instructions on the control panel.

Clearing Jams at Tray 1

1. Remove any paper from Tray 1.
2. If you did not find jammed paper, push up the latch on the left side of the printer to open Left Side Door A.

⚠️ **WARNING:** Internal parts of the printer can be hot. Use caution when doors and covers are open.

3. Remove any remaining paper jammed in Tray 1.

4. Close Left Side Door A.
5. Replace the paper in the tray.

   **Note:** Do not load paper above the maximum fill line. Overfilling can cause paper jams.

### Clearing Jams at Tray 2

1. Open Left Side Door A.

2. Remove the jammed paper.
3. Close Left Side Door A.

4. Pull Tray 2 out until it stops.

5. Remove any crumpled paper from the tray.
6. Verify that the paper is loaded correctly in the tray and that the guides are pressed firmly against the paper.

*Note:* For a Paper Size Jam message, remove the paper to adjust the paper guides. For details, see Paper Misfeeds and Paper Size Jams on page 135.

7. Push the tray completely back into the printer.

**Clearing Jams at Trays 3–5 of the 1500-Sheet Feeder**

1. Open Left Side Door C.
2. Remove the jammed paper.

3. Close Left Side Door C.

4. Pull out the tray specified on the control panel.
5. Remove any crumpled paper from the tray.

6. Verify that the paper is loaded correctly in the tray and that the guides are pressed firmly against the paper.

   Note: For a Paper Size Jam message, remove the paper to adjust the paper guides. For details, see Paper Misfeeds and Paper Size Jams on page 135.

7. Push the tray completely back into the printer.
Clearing Jams at Trays 3–4 of the 2500-Sheet Feeder

For details on clearing jams at Trays 3-4, see Clearing Jams at Trays 3-5 of the 1500 Sheet Feeder on page 109.

Clearing Jams at Tray 5 of the 2500-Sheet Feeder
1. Open Left Side Door C.

2. Remove the jammed paper.

3. Close Left Side Door C.
4. Pull out the tray until it stops.

5. Remove any paper from under the transport cover.

6. Remove any crumpled paper from the tray and torn paper from the paper path above the tray.

7. Push the tray completely back into the printer.
Clearing Jams at Left Side Door A

1. Open Left Side Door A.

2. Remove the jammed paper.

3. Open the fuser by pulling out the green handle.

⚠️ **WARNING:** The area around the fuser can be hot. Use caution to avoid injury.
4. Remove the jammed paper.

5. Close the fuser by pushing in the green handle until it stops.

⚠️ **CAUTION:** To avoid damage to the printer, verify that the fuser is closed before proceeding.

6. Close Left Side Door A.
Clearing Jams in the Duplex Unit at Left Side Door B

1. Open Tray 1.

2. Open Left Side Door B.

3. Remove the jammed paper.
4. Close Left Side Door B.

Clearing Jams in the Duplex Unit at Left Side Doors A and B

1. Open Left Side Door A.

⚠️ **WARNING:** Internal parts of the printer can be hot. Use caution when doors and covers are open.

2. Remove the jammed paper.
3. Close Left Side Door A.

4. Open Left Side Door B.

5. Remove the jammed paper.

6. Close Left Side Door B.
Clearing a Paper Size or Type Jam in Tray 1

1. Remove any paper from Tray 1.

2. Open Left Side Door A.

⚠️ **WARNING:** Internal parts of the printer can be hot. Use caution when doors and covers are open.

3. Remove the jammed paper.
4. Close Left Side Door A.

5. Replace the paper in the tray specified on the control panel with the specified paper size and type.
Clearing Jams in the Advanced Finisher

This section includes:

- Clearing Jams Under the Advanced Finisher Top Cover ................................................................. 121
- Clearing Jams in the Advanced Finisher Transport .............................................................................. 122

Clearing Jams Under the Advanced Finisher Top Cover

1. Pull up the lever on the top cover.

2. Open the top cover by rotating it to the left.
3. Remove the jammed paper.
   
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

4. Close the top cover of the finisher.

**Clearing Jams in the Advanced Finisher Transport**

1. Lift the handle of the center tray straight up to open the transport cover.

2. Remove the jammed paper.
   
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

3. Close the transport cover.
Clearing Jams in the Professional Finisher

This section includes:

- Clearing Jams in the Center Tray ........................................................................................................ 123
- Clearing Jams in the Professional Finisher Transport ......................................................................... 124
- Clearing Jams at 2a in the Finisher ...................................................................................................... 125
- Clearing Jams at 2b in the Finisher ...................................................................................................... 126
- Clearing Jams at 3 in the Finisher ....................................................................................................... 128
- Clearing Jams at 4a in the Finisher ...................................................................................................... 129
- Clearing Jams at 4b in the Finisher ...................................................................................................... 130
- Clearing Jams at 5 in the Finisher ....................................................................................................... 131
- Clearing Jams in the Booklet Tray ...................................................................................................... 132

Clearing Jams in the Center Tray

1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

2. Open, then close, the finisher transport cover.
Clearing Jams in the Professional Finisher Transport

1. Open the finisher transport cover.

2. Remove the jammed paper.

   Note: If the paper is torn, remove all torn pieces from the finisher.

   If no paper is visible, turn green knob 1 in the direction shown and carefully pull out the jammed paper.

3. Close the transport cover.
Clearing Jams at 2a in the Finisher

1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown.

2. Open the front door of the finisher.

3. Move green lever 2a to the right.

4. Remove the jammed paper.
5. To release paper that is inaccessible, or if the control panel displays a message to do so, turn knob 2c in the direction shown.

6. Carefully remove the paper.
   
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

7. Push lever 2a to its original position until it clicks in place.
8. Close the finisher front door.

**Clearing Jams at 2b in the Finisher**

1. Open the finisher front door.
2. Move green lever 2b to the right.

3. Remove the jammed paper.

4. To release paper that is inaccessible, or if the control panel displays a message to do so, turn knob 2c in the direction shown.

5. Carefully remove the paper.
   
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

6. Return lever 2b to its original position.
7. Close the finisher front door.
Clearing Jams at 3 in the Finisher

1. Open the front door of the finisher.

2. Pull down green lever 3.

3. Remove the jammed paper.
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

4. Return lever 3 to its original position.
5. Close the finisher front door.
Clearing Jams at 4a in the Finisher

1. Open the front door of the finisher.

2. Using the green handle, pull out unit 4 until it stops.

3. Turn green knob 4a in the direction shown to release the jammed paper.

4. Carefully remove the paper.
   
   **Note**: If the paper is torn, remove all torn pieces from the finisher.

5. Return unit 4 to its original position.

6. Close the finisher front door.
Clearing Jams at 4b in the Finisher

1. Open the front door of the finisher.

2. Move green lever 4b to the left.

3. If paper is visible, remove the jammed paper by pulling in the direction shown.

4. Using the green handle, pull out unit 4 until it stops.
5. Turn green knob 4a in the direction shown to release the jammed paper.

6. Carefully remove the paper from the upper left side and from inside the unit.
   Note: If the paper is torn, remove all torn pieces from the finisher.

7. Return unit 4 to its original position.
8. Return lever 4b to its original position.
9. Close the finisher front door.
Troubleshooting

Clearing Jams at 5 in the Finisher

1. Open finisher exit door 5 by lifting upward at the green label 5.

2. To remove the paper, pull it in the direction shown.
   
   Note: If the paper is torn, remove all torn pieces from the finisher.

3. Return exit door 5 to its original position.
Clearing Jams in the Booklet Tray

1. Open the front door of the finisher.

2. Turn green knob 4a in the direction shown to release the jammed paper.

3. To remove the paper, pull it in the direction shown.
   
   **Note:** If the paper is torn, remove all torn pieces from the finisher.

4. Close the finisher front door.
Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path.

The following can cause paper jams:
- Selecting the incorrect paper type in the print driver.
- Using damaged paper.
- Using unsupported paper.
- Loading paper incorrectly.
- Overfilling the tray.
- Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:
- Use only supported paper. For details, see Supported Paper on page 36.
- Follow proper paper handling and loading techniques.
- Always use clean, undamaged paper.
- Avoid paper that is curled, torn, moist, creased, or folded.
- To separate the sheets before loading into the tray, fan the paper.
- Observe the paper tray fill line; never overfill the tray.
- Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.
- After loading the trays, select the correct paper type and size on the control panel.
- When printing, select the correct type and size in the print driver.
- Store paper in a dry location.
- Use only Xerox® paper and transparencies designed for the printer.

Avoid the following:
- Polyester coated paper that is specially designed for inkjet printers.
- Paper that is folded, wrinkled, or excessively curled.
- Loading more than one type, size, or weight of paper in a tray at the same time.
- Overfilling the trays.
- Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/paper.
Troubleshooting Paper Jams

This section includes:

- Multiple Sheets Pulled Together ................................................................. 135
- Paper Misfeeds and Paper Size Jams ............................................................. 135
- Label and Envelope Misfeeds ....................................................................... 136
- Paper Jam Message Stays On ........................................................................ 136
- Jams During Automatic 2-Sided Printing ....................................................... 136

Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not even.</td>
<td>Remove the paper, align the edges, and then reload it.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the paper from the tray, and replace it with new dry paper.</td>
</tr>
<tr>
<td>Too much static electricity is present.</td>
<td>• Try a new ream of paper.</td>
</tr>
<tr>
<td></td>
<td>• Do not fan transparencies before loading in tray.</td>
</tr>
<tr>
<td>The feed rollers are worn.</td>
<td>Replace the feed rollers. For details, see Customer Replaceable Units on page 96.</td>
</tr>
<tr>
<td>Using unsupported paper.</td>
<td>Use only Xerox®-approved paper. For details, see Supported Paper on page 36.</td>
</tr>
<tr>
<td>Humidity is too high for coated paper.</td>
<td>Feed paper one sheet at a time.</td>
</tr>
</tbody>
</table>

Paper Misfeeds and Paper Size Jams

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed paper and reposition it properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>1. Remove the paper.</td>
</tr>
<tr>
<td></td>
<td>2. Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td></td>
<td>3. Replace the paper.</td>
</tr>
<tr>
<td>The feed rollers are worn.</td>
<td>Replace the feed rollers. For details, see Customer Replaceable Units on page 96.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Use paper of the correct size, thickness, and type.</td>
<td>Use only Xerox®-approved paper. For details, see Supported Paper on page 36.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Label and Envelope Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The label sheet is facing the wrong way in the tray. | Load label sheets according to the instructions from the manufacturer.  
  * Load labels face down in Tray 1.  
  * Load labels face up in Tray 2. |
| Envelopes are loaded incorrectly in Tray 1. |  
  * Load envelopes in Tray 1 with the flaps closed, flap-side up, and the long edge leading into the printer.  
  * Load C4 and custom-size envelopes longer than 320 mm (12.6 in.) with the print side down, flaps closed, flap-side up and leading into the printer. |
| Envelopes are loaded in the wrong tray. | Always use Tray 1 to print envelopes. |
| The feed rollers are worn. | Replace the feed rollers. For details, see [Customer Replaceable Units](#) on page 96. |

### Paper Jam Message Stays On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some paper remains jammed in the printer.</td>
<td>Recheck the media path and make sure that you have removed all of the jammed paper.</td>
</tr>
<tr>
<td>One of the printer doors is open.</td>
<td>Check the doors on the printer. Close any door that is open.</td>
</tr>
</tbody>
</table>

*Note:* Check for, and remove, torn pieces of paper in the paper path.

### Jams During Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use paper of the correct size, thickness, and type.</td>
<td></td>
</tr>
</tbody>
</table>
  * Use paper of the correct size, thickness, and type. For details, see [Supported Paper Sizes and Weights for Automatic 2-Sided Printing](#) on page 40.  
  * Do not use transparencies, envelopes, labels, reloaded paper, or paper heavier than 220 g/m² for automatic 2-sided printing. |
| Paper is loaded in the wrong tray. | The paper must be loaded in the correct tray. For details, see [Supported Paper](#) on page 36. |
| Tray is loaded with mixed paper. | Load the tray with only one type and size of paper. |
Clearing Main Staple Jams in the Professional Finisher

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Hold the stapler assembly by the orange lever R1 and push it to the right.
3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. Check inside the finisher for any loose staples and remove them.

4. Pull the staple cartridge clamp firmly in the direction shown to open it.

5. Remove the jammed staples by pulling them in the direction shown.

⚠️ **WARNING:** The points of the jammed staples are sharp. Remove the jammed staples carefully.

6. Push the clamp in the direction shown until it snaps into the locked position.
7. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until it clicks.

8. Close the finisher front door.

**Clearing Booklet Staple Jams in the Professional Finisher**

The stapler in the booklet maker uses two staple cartridges labeled R2 and R3. Booklet stapling requires that both staple cartridges be free of jammed staples.

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. While squeezing the orange levers R2 and R3 together (1), pull the stapler assembly out of the finisher until it stops (2).

   **Note:** The stapler assembly does not detach from the finisher.
3. Grip the orange tabs on both sides of the staple cartridge.

4. While gripping the orange tabs of the staple cartridge, rotate it in the direction shown.

5. Lift the staple cartridge out of the stapler unit.

6. Remove the jammed staples by pulling them in the direction shown.

**WARNING:** The points of the jammed staples are sharp. Remove the jammed staples carefully.
7. Push the new staple cartridge into the stapler unit until it clicks.

8. If you find no jammed staples, repeat the preceding steps for the other staple cartridge.
9. Return the staple cartridge assembly to its original position.

10. Close the finisher front door.

**Clearing Staple Jams in the Advanced Finisher**

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher front door.
2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
3. Push the stapler assembly to the right as shown.

4. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it.

5. Check inside the finisher for any loose staples and remove them.
6. Pull the staple cartridge clamp firmly in the direction shown to open it.

7. Remove the jammed staples by pulling them in the direction shown.

⚠️ **WARNING:** The points of the jammed staples are sharp. Remove the jammed staples carefully.
8. Push the clamp in the direction shown until it snaps into the locked position.

9. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until it clicks.

10. Close the finisher front door.

Clearing Booklet Staple Jams in the Advanced Finisher

⚠️ **WARNING:** Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.
Troubleshooting

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide them to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.

4. Remove the jammed staples by pulling them in the direction shown.
5. Hold the tabs on both sides of the staple cartridge and insert it into the original position in the finisher.

   **Note:** If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the cartridge.

   ![Staple Cartridge Insertion](image)

   **Note:** The Booklet Maker uses two staple cartridges. Booklet stapling requires that both staple cartridges contain staples.

6. Starting at Step 2, repeat the procedure for the other staple cartridge.

7. Close the finisher side cover.
Print-Quality Problems

This section includes:

- **Controlling Print Quality** .......................................................... 146
- **Solving Print-Quality Problems** ..................................................... 147

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/7800support.

⚠️ **CAUTION:** The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Notes:

- To ensure consistent print quality, the toner cartridges and imaging units for many models of equipment are designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color pages counter, because color consumables are used. Composite black is the default setting on most printers.

**Controlling Print Quality**

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal print quality is: 15–28°C (59–82°F) and 20–70% relative humidity.
Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox® approved paper. For details, see Supported Paper on page 36.
- Use only dry, undamaged paper.

⚠️ CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

- Ensure the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For details, see Paper Storage Guidelines on page 37.

Print-Quality Modes

Select the correct print-quality setting for your print job from the print driver. For instructions on setting the print quality, see Selecting Printing Options on page 59. To control the print quality:

- Ensure that the print quality is set to the correct mode. For example, if the image does not appear as vivid and sharp as you expect, set the print quality to Photo. The default setting is Standard.
- Use the print-quality settings in the print driver to control print quality. If the print quality is not suitable, adjust the print-quality setting to an higher level.
- Use only Xerox® approved paper. For details, see Supported Paper on page 36.
Solving Print-Quality Problems

Use the following table to find solutions to print-quality problems.

### Print-Quality Problems and Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Smears, Smudges, and Streaks<br>Dark or light marks appear on your output. | Run the Fuser Cleaning procedure. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Smears, Smudges, and Streaks > Start Cleaning**. Several blank pages feed through the printer to remove toner accumulated on the fuser. If the problem persists, print the test pages to help determine which component is causing the image-quality problem.  
- If the defect occurs in one color only, replace the corresponding imaging unit.  
- If the defect occurs in all colors and is visible on all the test pages, replace the fuser. |
| Repeating Spots or Lines<br>Spot or lines appear at regular intervals on the prints. | 1. To identify the part of the printer that is causing the problem, print the Repeating Defects page. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Repeating Spots or Lines > Print**.  
2. To identify the part responsible for the repeating spots or lines, follow the instructions on the Repeating Defects page.  
3. To correct the problem, replace the printer part identified on the Repeating Defects page.  

**Note:** To view a video on resolving this problem, touch **Printer > Tools > Troubleshooting > Resolve Problems**. Then select a topic and touch the video icon in the top bar to view the video. |
| Colors Look Wrong<br>Colors are off or look drastically wrong. | 1. Verify that the printer is on a solid, level, and flat surface.  
2. Perform the Calibrate Color procedure. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Colors Look Wrong > Calibrate Color**, then follow the instructions. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Colors Too Light or Too Dark           | 1. Verify that the paper you are using is the correct type for the printer and is loaded properly. For information on supported paper types and weights, at the control panel, touch **Printer > Print Reference Materials > Paper Tips > Print** to print the Paper Tips pages.  
2. Verify that the paper loaded in the tray matches the paper type selected at the control panel and in the print driver.  
3. Print the Color Reference page. At the control panel, touch **Printer > Print Reference Material > Color Reference > Print**. If the Color Reference page looks correct, the printer is printing properly. Your application or incorrect settings in the print driver can be causing the print-quality problems.  
4. If the Color Reference page did not print correctly, perform the Calibrate Color procedure. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Colors Look Wrong > Calibrate Color**, then follow the instructions.  
   **Note:** To view a video on resolving this problem, touch **Printer > Tools > Troubleshooting > Resolve Problems**. Then select a topic and touch the video icon in the top bar to view the video. |
| Page Margins Are Inconsistent          | Use the image position tool to adjust the image position on the page. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Page Margins are Inconsistent > Image Position**, then follow the instructions. |
| Sides 1 and 2 Are Not Aligned          | 1. To check alignment, hold your print up to a strong light and look for the shadow cast by Side 2.  
2. Perform the Image Position procedure. At the control panel, touch **Printer > Tools > Troubleshooting > Resolve Problems > Sides 1 & 2 Are Not Sufficiently Aligned**.  
3. Touch **Image Position**, then follow the instructions. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Vertical White Lines or Streaks - One Color Lines or streaks appear in one color of your output. | 1. Print the test pages to identify the affected color.  
2. To clean the LED window for the affected color, pull out the cleaning rod until it stops, then move it all the way in. Repeat three more times. Then repeat this procedure for each affected color.  
Notes:  
- To print procedures on resolving print-quality problems, touch Printer > Tools > Troubleshooting > Troubleshoot Print Quality > Print.  
- To view a video on resolving this problem, touch Printer > Tools > Troubleshooting > Resolve Problems. Then select a topic and touch the video icon in the top bar to view the video. |

| Toner Missing or Easy to Rub Off | 1. Verify that the paper you are using is the correct type for the printer and is loaded properly. For information on supported paper types and weights, at the control panel, touch Printer > Print Reference Materials > Paper Tips > Print to print the Paper Tips pages.  
2. Perform the Calibrate Paper Type procedure. For details, see Optimizing Printer Performance on page 29.  
3. At the control panel, select a heavier paper.  
Note: Papers from lightest to heaviest are:  
- For uncoated paper: Plain, Lightweight Cardstock, Cardstock, Heavyweight Cardstock, and Extra Heavyweight Cardstock.  
- For coated paper: Lightweight Glossy Cardstock, Glossy Cardstock, Heavyweight Glossy Cardstock, and Extra Heavyweight Glossy Cardstock. |

|  |  |
Print-Quality Problems with Glossy Paper

If roller marks are visible on glossy paper, you can reduce roller marks by using a different glossy paper or by lowering the fuser temperature. If you want to increase the amount of gloss on the print, use a different glossy paper or increase the fuser temperature. However, increasing the fuser temperature can also increase the visibility of roller marks.

You can adjust the default fuser temperature setting for each glossy paper type setting.

Adjusting the Fuser Temperature

1. Determine the current temperature setting:
   a. To see the current temperature setting for each paper type, print the Printer Status page. At the control panel, touch Printer.
   c. Touch the Print icon and select Printer Status.

2. To adjust the fuser temperature, download a PostScript file to the printer:
   a. Download the appropriate fuser adjustment PostScript snippet file from www.xerox.com/office/7800drivers. There are several temperature adjustment files for each paper type.
   b. To send the file to your printer, use CentreWare Internet Services. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.

   Note: If you do not know the IP address for your printer, see Finding the IP Address of Your Printer on page 24.

   c. In CentreWare Internet Services, click the Print tab.
   d. Click Browse or Choose File, navigate to the temperature adjustment file, then click Open or Choose.
   e. Click Submit Job.

3. To confirm that the temperature setting changed, print the Printer Status page again.
Getting Help

This section includes:

- Control Panel Messages ................................................................. 152
- Using the Integrated Troubleshooting Tools ........................................ 155
- More Information ........................................................................... 158

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning condition occurs, the control panel displays a message informing you of the problem. In many cases, the control panel also displays an animated graphic showing the location of the problem, such as the location of a paper jam. For many status and warning messages, the control panel Help provides additional information.

Control Panel Help

To view additional information about items and selections that appear on the control panel, touch Help. The Help button is labeled with a question mark symbol (?).

The control panel menu items also have associated help text that describes the menu item.
Viewing Warning Messages on the Control Panel

When a warning condition occurs, a message appears on the control panel to inform you of the problem. Warning messages inform you about printer conditions, such as low supplies or open doors, that require your attention. If more than one warning condition occurs, only one is displayed on the control panel.

To view a list of current warning messages:
1. At the control panel, touch **Printer**.
2. Touch **Current Messages**.
3. To return to the Troubleshooting screen, touch **Back**, or, to return to the main screen, touch **Home**.

Viewing Current Faults on the Control Panel

When a fault condition occurs, a message appears on the control panel to inform you of the problem. Fault messages warn you about printer conditions that prevent the printer from printing or degrade printing performance. If more than one fault occurs, only one is displayed on the control panel.

To view a list of the current faults on the control panel:
1. At the control panel, touch **Printer**.
2. Touch **Current Faults**.
   A list of the current faults appears on the screen.
3. To view fault details, touch a fault.
4. To close the screen, touch **X**.
5. To return to the Troubleshooting screen, touch **Back**, or, to return to the main screen, touch **Home**.

Viewing the Fault History on the Control Panel

When faults occur, they are logged in to a fault history file by date, time, and fault code. Use this list to identify trends and resolve problems.

To view the fault history:
1. At the control panel, touch **Printer**.
2. Touch the **Tools** tab, then touch **Troubleshooting**.
3. Touch **Fault History**.
   The screen displays the number, date, and time for each fault code.
4. To view fault details, touch a fault.
5. To return to the Troubleshooting screen, touch **Back**, or, to return to the main screen, touch **Home**.
Viewing Job Status on the Control Panel

To view active jobs on the control panel:
1. At the control panel, touch **Jobs**.
2. Touch the job you want to view.
   The screen displays information about the job such as the owner, type, status, and time submitted.

To view personal and secure jobs on the control panel:
1. At the control panel, touch **Jobs**.
2. Touch **Personal and Secure Jobs**.
   A list of assigned folders appears.
3. Touch your assigned private folder.
4. Do one of the following:
   - Type the passcode assigned to the job, then touch **OK**. A list of the stored personal and secure print jobs appears.
   - Touch **Skip Passcode and only show Personal Jobs**. A list of your personal jobs appears.
5. Touch the job you want to view.
   The screen displays information about the job such as the owner, type, status, and time submitted and completed.
   To print the job, see **Personal Print** on page 73 or **Secure Print** on page 72.
6. To return to the main screen, touch **Home**.

To view saved jobs on the control panel:
1. At the control panel, touch **Jobs**.
2. Touch **Saved Jobs**.
   A list of folders appears.
3. To view public saved jobs, touch **Public**.
   A list of public saved jobs appears.
4. To view private saved jobs, touch the assigned private folder.
5. Type the passcode assigned to the job, then touch **OK**.
   A list of private saved jobs appears.
6. Touch the job you want to view.
   The screen displays information about the job such as the owner, type, status, and time submitted and completed.
   To print the job, see **Saved Job** on page 72.
7. To return to the main screen, touch **Home**.
To view completed jobs on the control panel:
1. At the control panel, touch Jobs.
2. Touch Completed Jobs.
   The Completed Jobs screen displays the last 50 completed jobs.
3. Touch the job you want to view.
   The screen displays information about the job such as the owner, type, status, and time submitted and completed.
4. To return to the Completed Jobs screen, touch Back, or to return to the main screen, touch Home.

Using the Integrated Troubleshooting Tools

You can use several integrated tools, such as Information Pages, CentreWare Internet Services, and Job Tracker, to troubleshoot print quality and jam problems.

Printing Information Pages

1. At the control panel, touch Printer.
3. To set the quantity, touch #.
4. To select the number of copies to print, touch + or -, or type a number using the keypad.
5. Touch OK.
6. To scroll through the list as needed, use the Up or Down Arrow, then touch the page you want to print.
7. Touch Print.
   Note: You can also print Information pages from CentreWare Internet Services.

Specifying the Source Tray for Printing Information Pages

1. At the control panel, touch Printer.
2. Touch the Tools tab, then touch Tray Management > Information Pages Source.
3. Touch the specific tray you want the printer to use, or touch Automatic.
   Note: Tray 2 is the default paper source when Automatic is selected for printing Information Pages. If the tray is empty, the print request is held in the active job queue until paper is added or another tray is selected.
4. To confirm the setting, touch OK.
5. To return to the Tools tab, touch Back, or, to return to the main screen touch Home.
Printing the Configuration Report

1. At the control panel, touch Printer.
4. Touch Print.

Note: By default, the Configuration Report prints each time the printer is turned on. To turn off this setting, select Printer > Tools > Setup > General Settings > Startup Page > Off.

Viewing Billing and Usage Information

1. At the control panel, touch Printer.
2. On the Information tab, touch Billing Meters to see basic impression counts:
   - Color impressions: Number of pages printed that specify color.
   - Black impressions: Number of pages printed with no color specified.
   - Total impressions: Total number of color impressions plus black impressions.

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed on two sides counts as two impressions.
3. Touch Usage Counters to see detailed usage information.

Locating the Serial Number on the Control Panel

1. At the control panel, touch Printer.
2. On the Information tab, touch About This Printer.
   The General tab displays the model, serial number, version, and activation date.

Viewing Printer Supply Status

1. To view the Supplies tab, do one of the following:
   - At the control panel, touch the Printer button, then touch the Supplies tab.
   - Touch one of the C, M, Y, K icons in the lower right of the main screen.
2. To view details about a toner cartridge, including the part number for reordering, touch C, M, Y, or K.
3. Touch Close to return to the Supplies tab.
4. To view details about the fuser, waste cartridge, imaging units, maintenance kit, or staple cartridge, touch Other Supplies. Use the Up or Down Arrow to scroll through the list, then select the details you want to view.
5. Touch the Back arrow to return to the Other Supplies screen.
6. To print the Supplies Usage page, touch the Print icon, then touch Supplies Usage.
7. To return to the main screen, touch Home.
PhaserSMART Technical Support

PhaserSMART is an automated, Internet-based system that uses your Web browser to send diagnostic information from your printer to the Xerox® website. PhaserSMART examines the information, diagnoses the problem, and proposes a solution.

To access PhaserSMART Technical Support:
1. Open your Web browser and go to www.phaserSMART.com.
2. Enter the IP address of your printer in the form fields.
3. Follow the onscreen instructions.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 24.

To access PhaserSMART Technical Support from Job Tracker:
1. On the Device tab, click the PhaserSMART button at the bottom of the window.
2. Follow the onscreen instructions.

To access PhaserSMART Technical Support from CentreWare Internet Services:
1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.
2. On the Support tab, select the General tab.
3. Under Support Tools, click the PhaserSMART® Diagnostic Tool link.
4. Follow the onscreen instructions.

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser.

CentreWare Internet Services requires:
- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

To access CentreWare Internet Services:

At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.

If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 24.

To access CentreWare Internet Services from Job Tracker:

From the Job Tracker Menu, click Help, then select CentreWare Internet Services.
## More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide</strong></td>
<td>Packaged with printer</td>
</tr>
<tr>
<td><strong>Quick Use Guide</strong></td>
<td>Packaged with printer</td>
</tr>
<tr>
<td><strong>System Administrator Guide</strong></td>
<td><a href="http://www.xerox.com/office/7800docs">www.xerox.com/office/7800docs</a></td>
</tr>
<tr>
<td><strong>Video Tutorials</strong></td>
<td>Available on the printer control panel and at <a href="http://www.xerox.com/office/7800docs">www.xerox.com/office/7800docs</a></td>
</tr>
</tbody>
</table>
| **Recommended Media List**       | United States: [www.xerox.com/paper](http://www.xerox.com/paper)  
                        | Europe: [www.xerox.com/europaper](http://www.xerox.com/europaper) |
| **PhaserSMART Technical Support**| [www.phasersmart.com](http://www.phasersmart.com) |
| Technical support information for your printer includes online Technical Support, Online Support Assistant, and driver downloads. | [www.xerox.com/office/7800support](http://www.xerox.com/office/7800support) |
| **Information about menus or error messages** | Control panel Help (?) button |
| **Information pages**            | Print from the control panel menu             |
| Order supplies for your printer  | [www.xerox.com/office/7800supplies](http://www.xerox.com/office/7800supplies) |
| A resource for tools and information, such as interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs. | [www.xerox.com/office/businessresourcecenter](http://www.xerox.com/office/businessresourcecenter) |
| **Local sales and support center** | [www.xerox.com/office/worldcontacts](http://www.xerox.com/office/worldcontacts) |
| **Printer registration**         | [www.xerox.com/office/register](http://www.xerox.com/office/register) |
| **Xerox® Direct online store**   | [www.direct.xerox.com](http://www.direct.xerox.com/) |
Specifications

This appendix includes:

- Printer Configurations and Options ................................................................. 160
- Physical Specifications .......................................................................................... 162
- Environmental Specifications ............................................................................. 165
- Electrical Specifications ....................................................................................... 166
- Performance Specifications .................................................................................. 167
Specifications

Printer Configurations and Options

Standard Features

The Phaser 7800 Color Printer provides the following features:

- Maximum Print Resolution: 1200 x 2400 dpi
- Print document sizes up to 320 x 457 mm (12.6 x 18 in.)
- Print banners up to 1219 mm (48 in.) long
- Single pass LED technology with 1200-dpi printheads
- Automatic 2-sided printing
- Color touch screen control panel
- Tray 1 with 100-sheet capacity
- Tray 2 with 500-sheet capacity
- Internal 160 GB hard drive
- 1.33 GHz processor
- 2 GB RAM
- Universal Serial Bus (USB 2.0)
- Ethernet 10/100/1000Base-T
- PostScript and PCL fonts
- PostScript, PCL, and client-based XPS support
- Data Security
- GreenPrint software
- CentreWare Internet Services
- CentreWare Web
- PhaserCal
- Remote driver installation
- WebJet Admin Interface
- Tivoli
- Bonjour, SSDP, and SAP device discovery
- Email Alerts
- Automated Supplies Replenishment
- Proactive Supplies Management
Available Configurations

<table>
<thead>
<tr>
<th>Features</th>
<th>Phaser 7800DN Color Printer</th>
<th>Phaser 7800GX Color Printer</th>
<th>Phaser 7800DX Color Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard trays</td>
<td>2</td>
<td>5, including the 1500-Sheet Feeder</td>
<td>5, including the 2500-Sheet Feeder</td>
</tr>
<tr>
<td>Optional trays</td>
<td>3</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Finisher</td>
<td>No</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>PhaserMatch with PhaserMeter™</td>
<td>Optional</td>
<td>Yes</td>
<td>Optional</td>
</tr>
</tbody>
</table>

Options and Upgrades

- Advanced Finisher
- Professional Finisher
- 1500-Sheet Feeder
- 2500-Sheet Feeder
- Extra Heavy Duty Media Kit
- Hole Punch for Advanced Finisher
- Booklet Maker for Advanced Finisher
- PhaserMatch with PhaserMeter™
- Wireless Network Adapter
Specifications

Physical Specifications

Phaser 7800DN Color Printer Configuration
- Width: 641.4 mm (25.25 in.)
- Depth: 698.5 mm (27.5 in.)
- Height: 577.9 mm (22.75 in.)
- Weight: 81 kg (178.6 lb.)

Phaser 7800GX Color Printer Configuration
- Width: 641.4 mm (25.25 in.)
- Depth: 698.5 mm (27.5 in.)
- Height: 952.5 mm (37.5 in.)
- Weight: 116 kg (255.2 lb.)

Phaser 7800DX Color Printer Configuration
- Width: 641.4 mm (25.25 in.)
- Depth: 698.5 mm (27.5 in.)
- Height: 952.5 mm (37.5 in.)
- Weight: 125 kg (275 lb.)

Configuration with Advanced Finisher and Booklet Maker
- Width: 1666 mm (65.6 in.)
- Depth: 685 mm (27 in.), 695 mm (27.4 in.) with Booklet Maker
- Height: 1057 mm (41.6 in.)
- Weight:
  - Phaser 7800GX Color Printer: 153.2 kg (337 lb.)
  - Phaser 7800DX Color Printer: 162.2 kg (356.8 lb.)

Configuration with Professional Finisher
- Width: 1922 mm (75.7 in.)
- Depth: 685 mm (27 in.)
- Height: 1065 mm (41.9 in.)
- Weight:
  - Phaser 7800GX Color Printer: 206.7 kg (454.7 lb.)
  - Phaser 7800DX Color Printer: 215.7 kg (474.5 lb.)
Clearance Requirements

**Phaser 7800 Color Printer**

![Diagram of Phaser 7800 Color Printer]

10 cm (3.9 in.)

206.7 cm (81.4 in.)

177.8 cm (70.0 in.)

30.7 cm (12.1 in.)

**Phaser 7800 Color Printer with Advanced Finisher and Booklet Maker**

![Diagram of Phaser 7800 Color Printer with Advanced Finisher and Booklet Maker]

10 cm (3.9 in.)

206.7 cm (81.4 in.)

217.4 cm (86.0 in.)

88.5 cm (34.8 in.)
Phaser 7800 Color Printer with Professional Finisher

Specifications

Phaser 7800 Color Printer with Professional Finisher
Environmental Specifications

Temperature

- Operating: 10–32°C (50–90°F)
- Optimum print quality: 15–28°C (59–82°F)

Relative Humidity

- Operating: 15–85% (non-condensing)
- Optimum print quality: 20–70%

Elevation

For optimum performance, use the printer at elevations below 3200 m (10,500 ft.).
Specifications

Electrical Specifications

Power Supply Voltage and Frequency

<table>
<thead>
<tr>
<th>Power Supply Voltage</th>
<th>Power Supply Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>110–127 VAC +/- 10 %, (99–140 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
<tr>
<td>220–240 VAC +/- 10 %, (198–264 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
</tbody>
</table>

Power Consumption

<table>
<thead>
<tr>
<th>Peak Power</th>
<th>Ready to Print</th>
<th>Low Power (Standby)</th>
<th>Energy Saver Sleep</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200 W</td>
<td>85 W</td>
<td>60 W</td>
<td>6 W</td>
<td>0.7 W</td>
</tr>
</tbody>
</table>

ENERGY STAR Qualified Product

The Phaser 7800 Color Printer is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 15 minutes and 45 minutes from the last copy or print. For details, see Energy Saver Mode on page 23.
Performance Specifications

Printing Resolution

Maximum resolution: 1200 x 2400 dpi

- Standard print-quality mode: 1200 x 600 dpi
- Enhanced print-quality mode: 1200 x 2400 dpi
- Photo print-quality mode: 600 x 600 x 8 dpi

Note: The print resolutions are indicated for PostScript print drivers only. The only print resolution for PCL is 600 x 600 dpi.

Print Speeds

Print speeds are the same for color or black and white printing. Print speeds are the same for all print-quality modes, and are provided in pages per minute (ppm). Paper orientation is indicated as short-edge feed (SEF) or long-edge feed (LEF).

<table>
<thead>
<tr>
<th>1-Sided Printing</th>
<th>A4 / Letter LEF</th>
<th>A4 / Letter SEF</th>
<th>B4 SEF / 8.5 x 13 in. SEF, 8.5 x 14 in. SEF</th>
<th>A3 / 11x17 in.</th>
<th>SRA3 / 12x18 in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain, Hole Punched, Pre-Printed, Letterhead, Recycled, Custom</td>
<td>45 ppm</td>
<td>32 ppm</td>
<td>26 ppm</td>
<td>22 ppm</td>
<td>22 ppm</td>
</tr>
<tr>
<td>Lightweight Cardstock, Lightweight Glossy Cardstock, Labels</td>
<td>32 ppm</td>
<td>25 ppm</td>
<td>20 ppm</td>
<td>17 ppm</td>
<td>17 ppm</td>
</tr>
<tr>
<td>Cardstock, Glossy Cardstock, Envelope, Transparency</td>
<td>22 ppm</td>
<td>18 ppm</td>
<td>15 ppm</td>
<td>13 ppm</td>
<td>12 ppm</td>
</tr>
<tr>
<td>Heavyweight Cardstock, Heavyweight Glossy Cardstock</td>
<td>15 ppm</td>
<td>12.5 ppm</td>
<td>10 ppm</td>
<td>8 ppm</td>
<td>7 ppm</td>
</tr>
<tr>
<td>Heavyweight Cardstock, Extra Heavyweight Cardstock, Extra Heavyweight Glossy Cardstock</td>
<td>15 ppm</td>
<td>12.5 ppm</td>
<td>10 ppm</td>
<td>8 ppm</td>
<td>7 ppm</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>2-Sided Printing</th>
<th>A4 / Letter LEF</th>
<th>A4 / Letter SEF</th>
<th>B4 SEF / 8.5 x 13 in. SEF, 8.5 x 14 in. SEF</th>
<th>A3 / 11x17 in.</th>
<th>SRA3 / 12x18 in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain, Hole Punched, Pre-Printed, Letterhead, Recycled, Custom</td>
<td>45 ppm</td>
<td>32 ppm</td>
<td>17 ppm</td>
<td>15 ppm</td>
<td>15 ppm</td>
</tr>
<tr>
<td>Lightweight Cardstock, Lightweight Glossy Cardstock, Labels</td>
<td>32 ppm</td>
<td>25 ppm</td>
<td>15 ppm</td>
<td>13 ppm</td>
<td>13 ppm</td>
</tr>
<tr>
<td>Cardstock, Glossy Cardstock</td>
<td>22 ppm</td>
<td>18 ppm</td>
<td>9.7 ppm</td>
<td>8.8 ppm</td>
<td>8.2 ppm</td>
</tr>
<tr>
<td>Heavyweight Cardstock and Heavyweight Glossy Cardstock are only available if the Extra Heavy Duty Media Kit is installed.</td>
<td>15 ppm</td>
<td>12.5 ppm</td>
<td>6.5 ppm</td>
<td>5.7 ppm</td>
<td>5.3 ppm</td>
</tr>
</tbody>
</table>
This appendix includes:

- **Basic Regulations** .......................................................... 170
- **Material Safety Data Sheets** ............................................... 172
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.
**European Union**

⚠️ **CAUTION:** This is a Class A product. In a domestic environment, this product can cause radio interference in which case the user could be required to take adequate measures.

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

**Germany**

**Blendschutz**

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

**Lärmemission**

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß EN ISO 7779.

**Importeur**

Deutschland
Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss

**Turkey RoHS Regulation**

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

- North America: [www.xerox.com/msds](http://www.xerox.com/msds)
- European Union: [www.xerox.com/environment_europe](http://www.xerox.com/environment_europe)

Recycling and Disposal

This appendix includes:

- All Countries ......................................................... 174
- North America ....................................................... 175
- European Union ..................................................... 176
- Other Countries ..................................................... 178
All Countries

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate.
North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to determine if this Xerox® product is part of the program. For more information about Xerox® environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your local authorities.
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

**Domestic/Household Environment**

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

**Professional/Business Environment**

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.